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 Content of this Instruction Manual
 DPP stands for Digital Photo Professional.
 In this manual, the screens used in the basic

operation instructions are from Windows 8.1/10.
  indicates the selection procedure of the menu.
 Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.
 Text inside < > indicates a key on the keyboard.
 p.** indicates a reference page.
Click to move to the relevant page.
 Advanced indicates the function for advanced
users who are experienced in handling image
processing software.

: Marks helpful information when a problem
arises.





: Marks tips for using the software skillfully.
: Marks information that should be read
before use.
: Marks additional information you may find
helpful.

 Switching Between Pages
 Click on arrows on the bottom right of the screen.

: next page
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: previous page
: return to a page you had previously
displayed
 Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.
3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.
4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.
6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.
7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.
8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.
9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.
10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction
Main Features of DPP

 Color management compatibility
 CMYK simulation for commercial printing

Following are the main tasks you can perform with images you have
downloaded to your computer.
* JPEG/TIFF indicates processing that can be performed with JPEG or
TIFF images as well as RAW images.

Editing
Images

Printing
Images

 Various image adjustments while maintaining the original image
JPEG/TIFF

 Freely apply a Picture Style
 View your image before and after adjustment in the same window

Processing
Large Numbers
of RAW Images

JPEG/TIFF

 Trim and adjust the angle of an image
(trimming) JPEG/TIFF
 Resize an image JPEG/TIFF
 Correction of lens aberration
 Digital Lens Optimizer
 Automatic/manual dust erasure processing
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RAW Movies

JPEG/TIFF

HDR PQ
Mode

 Convert from a RAW image to a JPEG or
TIFF image and save
 Print an image JPEG/TIFF
 Link with EOS Utility for remote shooting
JPEG/TIFF

Viewing
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 View and organize images JPEG/TIFF
 Play back movies and save still photos
 Adjust an image

 Process large numbers of RAW images in batches
 Transfer the image to image editing software
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In DPP Ver. 4.8.20 or later, clicking [Check for updates] in the [Help]
menu allows you to check for update files on the server and
download any update files that are available.
To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.
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OS (operating
Windows 10 (Version 1607 or later)*, Windows 8.1*
system)
Model

PC with one of the above OS preinstalled
(Upgraded machines not supported)

CPU

Images shot with EOS-1D X Mark III, EOS R5,
EOS R6:
Intel Core i series (recommended Intel Core i7 or
later)
Images shot with other cameras:
Core 2 Duo 2.0 GHz or faster (recommended Core i
series or later)

RAM
(memory)

Sorting
Images
Editing
Images

Printing
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Images shot with EOS-1D X Mark III, EOS R5, EOS
R6:
4.0 GB or more of RAM (8.0 GB or more
recommended)
Images shot with other cameras:
2.0 GB or more of RAM (4.0 GB or more
recommended)

Hard disk
drive

Installation: Min. 300 MB of available space
Operation: Min. 600 MB of available space

Display

Resolution: XGA (1024 x 720) or more (1600 x 1200
or more recommended)
Colors: 16-bit color (65536 colors) or more

Processing
Large Numbers
of RAW Images
Remote
Shooting

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies

• Only supported on 64-bit OSs. Cannot be installed or used on 32-bit
version PCs.
* With Microsoft .NET Framework 4.7.1 or later installed

HDR PQ
Mode

 For information on system requirements for HDR PQ mode
(including supported images), see “System Requirements for
HDR PQ Mode” (p.166).
 For details on system requirements for the RAW movie tool, see
“Working with RAW Movies” (p.154).
 For images supported by depth compositing, see “Using Depth
Compositing”  “Supported Images” (p.117).
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Supported Cameras

Supported Images

EOS-1D X Mark III, EOS-1D X Mark II, EOS-1D X, EOS-1D C, EOS-1D Mark IV,
EOS-1Ds Mark III, EOS-1D Mark III, EOS-1D Mark II N, EOS-1Ds Mark II, EOS1D Mark II, EOS-1D, EOS-1Ds, EOS 5DS/EOS 5DS R, EOS 5D Mark IV, EOS
5D Mark III, EOS 5D Mark II, EOS 5D, EOS 6D Mark II, EOS 6D, EOS 7D Mark
II, EOS 7D, EOS 90D, EOS 80D, EOS 70D, EOS 60D/EOS 60Da, EOS 50D,
EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000, EOS
D6000, EOS D30, EOS D60, EOS 77D, EOS REBEL T6S/760D, EOS REBEL
T8i/850D, EOS REBEL T7i/800D, EOS REBEL T6i/750D, EOS REBEL T5i/
700D, EOS REBEL SL3/250D/200D II, EOS REBEL SL2/200D, EOS REBEL
SL1/100D, EOS REBEL T7/2000D/1500D, EOS REBEL T6/1300D, EOS
REBEL T5/1200D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS
REBEL T2i/550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D,
EOS DIGITAL REBEL XS/1000D, EOS REBEL T3/1100D, EOS DIGITAL
REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, EOS
REBEL T100/4000D/3000D, EOS DIGITAL REBEL/300D, EOS R5, EOS R6,
EOS R, EOS Ra, EOS RP, EOS M6 Mark II, EOS M6, EOS M5, EOS M3, EOS
M2, EOS M, EOS M10, EOS M200, EOS M100, EOS M50 Mark II, EOS M50,
PowerShot G3 X*1, PowerShot G1 X Mark II*1, PowerShot G7 X*1, PowerShot
G9 X*1, PowerShot SX60 HS*1, PowerShot G5 X*1, PowerShot G7 X Mark II*1,
PowerShot G16*1, PowerShot S120*1, PowerShot G1 X*1, PowerShot G15*1,
PowerShot S110*1, PowerShot S100*1, PowerShot G9 X Mark II*1, PowerShot
G1 X Mark III*1, PowerShot G9*1*2, PowerShot G10*1*2, PowerShot G11*1*2,
PowerShot G12*1*2, PowerShot S90*1*2, PowerShot S95*1*2, PowerShot SX1
IS*1*2, PowerShot SX50 HS*1*2, PowerShot SX70 HS*1*2, PowerShot G5 X
Mark II*1, and PowerShot G7 X Mark III*1
*1 For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if not in the
camera, can be used with the exception of some functionality.
*2 The following functions are unavailable.
- Basic Adjustment tool palette:
White balance [Fine-tune]
A portion of [Gamma adjustment]
Automatic gradation and luminance adjustment
Midpoint adjustment
Input white points range expansion
- Dust Delete/Copy Stamp tool palette
- Compositing tool
- HDR tool

Image data
Image type
RAW Images in the Canon RAW format
images shot on supported cameras*

Viewing
Images

Extension
.CR3
.CR2
.TIF
.CRW
.CIP

Still
JPEG Exif 2.2, 2.21 or 2.3-compatible JPEG
.JPG/.JPEG
photos images images
TIFF
Exif-compatible TIFF images
images

.TIF/.TIFF

HEIF Images shot on supported cameras,
images or HEIF images developed in DPP

.HIF/.HEIC

.MOV
.MP4
.CRM
* Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.
Movies

Movies shot with supported cameras
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JPEG/TIFF image editing.
: Certain functions explained in the section support
JPEG/TIFF image editing.
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Starting up DPP
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Double-click the desktop icon.
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Double-click
 DPP starts up and the main window (thumbnail layout) appears.
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If you drop a DPP-supported image file onto the icon on the
desktop, you can start up DPP and display the folder where the
image file is saved.

10

Downloading Images to Your Computer
Download the images saved on the memory card inserted in the
camera.

Downloading Images Using the Software “EOS Utility”
You can download images with “EOS Utility”, communication software
for the camera.
For detailed instructions on downloading images, refer to the “EOS
Utility Instruction Manual” (PDF electronic manual).

Downloading Images Using Your Card Reader
You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.

1
Open [My Computer]  [EOS_DIGITAL] and drag the
2 [DCIM]
folder to the [Desktop].
 Start up DPP beforehand.

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images
Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images
Remote
Shooting

 The [DCIM] folder is copied to your computer.
 All images are saved in folder units inside the [DCIM] folder.
 Copying images to your computer will take some time when there
is a large number of images saved on the memory card.
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Viewing Images in the Main Window (Thumbnail Layout)
Images downloaded to your computer are displayed as a thumbnails list
in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.18) and display the image at large size.
Main window
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Forward/Reverse

Check marks (p.33, p.34)
Rotate image
Ratings (p.33, p.34)
 For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.184).

Handling
RAW Movies
HDR PQ
Mode

 For information on movie files, see “Playing Back Movies and
Saving Still Photos” (p.150).
 When aspect ratio information is attached to an image shot with
any supported camera other than the EOS 5D Mark II, the image
is displayed as a cropped image (p.71).
 In the main window, in addition to this view (thumbnail layout),
you can select multi-layout. Multi-layout allows you to check the
image in detail (p.20).

Specifying
Preferences

13

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

Changing the Thumbnail Display
You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu  desired item.
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 The display changes to the selected item.
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Advanced

Using the Thumbnails Control Panel

Viewing
Images

The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Sorting
Images

Thumbnails control panel functions
(1)

(2) (3) (4) (5) (6) (7) (8)

(9) (10)

Editing
Images

Printing
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(1)

Change the size of thumbnails

(2)

Display thumbnails without file names

(3)

Display standard thumbnails

(4)

Display thumbnails with information

(5)

Display thumbnails in list

(6)
(7)

Specify properties display settings (p.179)
Display a RAW image and JPEG image as a single image
Display a RAW image and JPEG image that were shot together
as a single image. When this setting is specified, viewing and
editing of images are as follows.

(8)

Display or play back split movie files as single movies
When you play back split movie files in DPP, this setting plays
back all the movie files in a continuous sequence from the
beginning.
• This is set to ON by default.
• Only the thumbnail for the first movie file is displayed.
• This setting will be kept and applied the next time DPP is
started up.
• When the following functions are used, they apply to all the
remaining split movie files, not just the first movie file:
[Copy], [Cut], [Delete], [Add to collection], [Rename Tool]
• When the Filter/Sort function (p.16) is used with thumbnails,
the function is only applied to the first movie file.

• Image displayed: Only the RAW image is displayed in all
(9)
Select all thumbnails
windows.
(10)
Cancel all thumbnail selections
• Edited image: The content which has been edited with any of
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following
 The thumbnails control panel is displayed in the main window by
functions, the adjustments will be applied to both the RAW
default. If it is not displayed, such as when screen settings have
image and the JPEG image.
been changed, you can display it by selecting [Thumbnail control
Deleting an image (p.39)
panel] in the [Thumbnails] menu.
Moving or copying an image (p.39)
 In multi-layout (vertical thumbnails, p.20), only the thumbnail view
Checkmarking (p.33 to p.34)
setting (Default thumbnail display) is possible.
Rating (p.33 to p.34)
Rotating an image (p.13)

Processing
Large Numbers
of RAW Images
Remote
Shooting

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies
HDR PQ
Mode

Specifying
Preferences

15

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

Advanced

Using the Thumbnail Display Filter/Sort
Function
This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

the [Filter] button on the [Filter/Sort pane] in the
1 Set
main window to [ON].

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a “*” is
temporarily displayed after the option name. [Custom] is displayed if
you sorted thumbnails in a chosen way.

2 Specify settings.
(1)

(2) Filtering options menu
Select a filtering option for the thumbnail display filter.
• After selecting a filtering item in the list box that appears by clicking
[] at the right on the filter menu, options appear in the filter menu
list. Select an option.
• You can select multiple options in the filter menu list.
(Hold down the <Shift> key and left-click with the mouse for
consecutive selection. Hold down the <Ctrl> key and left-click with
the mouse to select individually.)
• The filter menus/filter menu lists are prioritized from left to right.
You can specify filtering options from left to right to narrow down
filtering.

(5)

(3)

(4)

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.
(5) Filter lock button
When the filter lock button is clicked, filter settings will be kept and
applied when you switch to a different folder or the next time DPP is
started up. When the filter lock button is not clicked, filter settings
automatically change to [OFF] when you switch to a different folder
or the next time DPP is started up.

Filter menu
Filter menu list

(2)

Drag to adjust display area of filter
menu lists upward or downward

 You can drag the bottom edge of the [Filter/Sort pane] to adjust
the display area of the filter menu lists upward or downward.

 In addition to thumbnail display, this function can also be used in
multi-layout.
 You can open/close the panel by clicking the [] button at the
upper right of the [Filter/Sort pane].
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(1) Thumbnail display filter ON/OFF
By setting to [ON], only thumbnails matching the filtering option set
with (2) the filtering options menu are displayed.
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Displaying the Histogram Palette
The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu  [Histogram palette].
 The histogram palette appears.
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 You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]
 You can click the [
] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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Enlarging and Viewing an Image in the Preview Window
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Double-click
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 The preview window appears.
 Up to 36 windows can be displayed at the same time for the
preview window.

Preview window
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 Click the [ ] in the upper right of the preview window to close
the preview window.

By selecting the [Preview] menu  [AF points] in the preview
window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.95), images for which you selected an
effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or
chromatic aberration correction.
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Enlarging and Viewing a Specific Area
Click the area you want to enlarge.

Advanced

Displaying the Navigator Palette
The navigator palette shows the enlargement area of a selected image.

Select the [View] menu  [Navigator palette].
 The navigator palette appears.
Click

Viewing
Images
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 The area you clicked is enlarged to 100% (actual pixel size).
 Click again to revert to the full view.
 To change the display area drag on the image.

 When an image is enlarged in the preview or other window, the
enlargement display area is indicated in the navigator palette.
The area to be enlarged can be changed by dragging the
enlargement display area on the image.
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Change the enlargement
display area by dragging

 You can click the [
] button at the bottom right of the main
window to show/hide the [Navigator] palette.
To display an image in an enlargement ratio other than 100%
Select any enlargement ratio from the [Preview] menu.
While in the preview window, you can select the [Preview] menu 
[Preview control panel] to use various preview functions. For details,
see “Checking an Image Using the Preview Control Panel” (p.21).
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Advanced

Checking the Image in Detail
Displaying the Main Window (Multi-layout)

Viewing
Images

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).
 The main window (multi-layout) appears.
 In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.
 Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the
image again to revert to full display.
Multi-layout (horizontal thumbnails)

Main Window (thumbnail layout)
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Checking an Image Using the Preview Control Panel
With Preview control panel, you can check the image in detail.
You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [ ] button and [ ] button are selected. When you select a
movie, the displayed content changes. For information on the display
when movies are selected, see “Playing Back Movies and Saving Still
Photos” (p.150).

Comparing with a Pinned (Fixed) Image
You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.
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Select an image and click the [

] button.
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Changing the Magnification
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Display the image at actual pixel size (100%).

Remote
Shooting

Click the [ ] button to display the image at the set
magnification displayed. If the [
] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.
*Excluding actual pixel size (100%)

Playing Back
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Enlarge/reduce the image.
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RAW Movies

Revert the zoomed image back to fit-to-window view.

Pinned (fixed) image
 The window divides into left and right, and the selected image is
pinned.
 When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.
 To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.
 After pinning an image, you can click the [ ] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time

Displaying AF Points

Viewing
Images

Select multiple images, and click the [

] button.

 The selected image is displayed.
 You can display up to 8 images.

1

Click the [ ] button beside the [
] button, and
select the item to display on the image on the menu
that appears.
 Select [Show only AF points in focus] or [Show all AF points].

Displaying Grid Lines

2 Select an image and click the [

] button.

 An image with the AF points selected in step 1 is displayed.
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the [ ] button beside the [
] button, and set
1 Click
the spacing between grid lines on the menu that

Remote
Shooting

appears.

2

Sorting
Images

 To set the spacing, enter values (8 to 256, in pixels), or move the
slider.
 After specifying settings, click the [Close] button and close the
window.
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Select an image and click the [
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] button.

 The image with grid lines is displayed.
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AF points are not displayed for images whose image size has been
changed and then been converted and saved (p.95), images for
which you selected an effect other than [Shot settings] as correction
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for
distortion correction or chromatic aberration correction.
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Displaying Areas Beyond the Set Range with
Warning Indicators (Highlight/Shadow
Warning)
You can set up warning indicators for both highlighted and shadowed
parts, which is effective for checking the clipped highlights and shadows
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted
part in red and the shadowed part in blue.

2

Select an image and click the [

] button.

 On the opened image, if there is an area that exceeds the value
entered in step 1, the highlighted part of that area is displayed in
red and the shadowed part is displayed in blue. If you selected
different warning colors, the parts are displayed in the specified
colors.

Comparing Pre- and Post-Editing Images
(Single-Image Display)
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the [ ] button beside the [
] button, and
1 Click
specify settings on the menu that appears.

Select an image that is being edited and click the
[ ] button.
 By clicking the button, the display switches between the image
before editing and the current image (being edited).
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 Checkmark the [Show highlight warnings] and [Show shadow
warnings] checkboxes and enter the warning values.
You can also select different warning colors from the dialog that
appears when you click the [
] button.
 After specifying settings, click the [Close] button and close the
window.
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Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)
You can display before and after versions of an adjusted image in the
same window and check the adjustment results.
This function allows you to adjust an image while comparing the original
image and image being edited.

Displaying Image Properties
Display the shooting and recipe information for an image in the screen.
You can select items to be displayed.

Sorting
Images

Click the [ ] button beside the [

1
2 Specify display settings.

] button.

 The [Properties display settings] window appears.

an image that is being edited and click the
1 Select
[ ] button.
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 The image is displayed in two-screen display (Arrange vertically).
 The image before editing is on the left, and the currently edited is
on the right.

2 Change the image display.

 The display switches in the following order by clicking the [ ]
button.
Arrange vertically (two-screen: left/right)  Arrange horizontally
(two-screen: top/bottom)  Split vertically (split-image: left/right)
 Split horizontally (split-image: top/bottom)
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1 Select [Display settings for preview properties] from the

[Properties to display] pulldown menu.
2 Specify display items with the [Add >>] button and [<< Remove]
button. Items that can be selected appear in the list box at left,
and actually displayed items appear in the list box at right. You
can also change the display order with the [Move Up] button and
[Move Down] button.
After specifying settings, click the [OK] button.
 With the [Preview properties font] option, you can specify the font
used for information displayed in the preview window.

3 Select an image and click the [

] button.

 The image and properties selected in step 2 are displayed in the
screen.
 If the recipe contents of an image being edited are displayed in
before/after comparison (two-screen display/split-image display),
edited items are displayed in red.

Checking an Image in Multi-Function Preview
The preview window shows the coordinates of the mouse cursor and the
work color space. By switching to multi-function preview, you can also
check image details in the same way as the main window (multi-layout).

the [Tools] menu  [Preview screen display
1 Select
settings], and then [Multi-function preview] from the
dialog that appears.

2 Open the preview window

(p.18).

 A multi-function preview with various functions at the bottom of
the screen is displayed.
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 For how to use the displayed functions, see “Viewing an Image in
the Main Window (Thumbnail Layout)” (p.13) and “Checking an
Image Using the Preview Control Panel” (p.21 to p.25).
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All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.
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Checking an Image in Second Windows
Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,
etc.

Select an image, and then select [Show second
screen] from the menu that appears when you rightclick with the mouse.
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 A second window is displayed.
 To display an additional second window, repeat the operation.
 You can change the size of second windows as desired.
 Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.
 When you magnify an image in the second window, the rightclicked position on the image will be the center for the
magnification.
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Opening and Closing Window Panels (Panes)
Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [

] for a panel to open or close.

Example: main window (thumbnail layout)
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 When a panel is closed, you can point to [
to temporarily open the panel.

] with the mouse
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Changing the Display Method and Order of Palettes
For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes
Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
 A docked palette is then displayed floating, and a floating palette
is then displayed docked.
 To revert to the original display method, repeat the same
operation again.

Rearranging Palettes
When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.
 The order of the palettes is changed.
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Exiting DPP
In the main window, select the [File] menu  [Exit].
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 DPP exits.

Digital Photo Professional Survey Program
Canon requests that information related to your Canon product be
sent to Canon (in case of using your Canon product in China, to the
legally approved research company) through the Internet. Canon
uses such information for development and marketing of products
that better meet customer needs.
Even after agreeing, you can change the send settings anytime in
the [Survey] tab sheet (p.180) in [Preferences].
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A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images
adjusted.
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Efficiently Checking/Sorting Images
You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.
Note that this function does not apply to movie files.
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Click the [ ] or [ ] button to switch between
images to be checked.
Quick check window

1 Select multiple images to check in the main window.
2 Display the quick check window.
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 Click the [Quick check] button.
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 The quick check window appears.
 All the images displayed in the main window can be checked in
the quick check window.
 If you click the [ ] button, the first image is displayed, and if you
click the [ ] button, the last image is displayed.
 Click the [ ] button to return to the main window.
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4

Click the area you want to enlarge.

Convenient functions of the quick check window

Click

 The area you clicked is displayed at 100% (actual pixel size).
 To change the display position, drag on the image.
 If you click the [
] button, you can display the image at 50%.
 Click again to revert to the full view.
 To exit, click the [ ] button.

 In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [ ] button beside the
[
] button on the screen, and select a magnification from the
menu that appears.
 If you click the [
] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.
 When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.95), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

 To check only selected images
You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.
 Switching between images using the keyboard
You can also switch between images by pressing the <> or <>
key.
 Switching between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.
 Operations using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.
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Setting Ratings

Sorting Images
You can sort images by attaching check marks or setting ratings
(indicated with [ ] marks) for each subject or theme.

Display the image you want to rate, and then click
any one of the [ ].
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Images

Attaching Check Marks
Display the image you want to attach a check mark
to, and then click any one of [ ] to [ ].

Click
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Images

Printing
Images

Click
 The selected check mark appears in the upper left of the window.
Check mark

 The rating is set and an icon corresponding to the selected [ ]
appears in the upper left of the window.
(Window shown with a rating of three [ ])
 To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.
Rating icon
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 Click the [Clear] button to remove the check mark.

HDR PQ
Mode

 To cancel the rating, click the same [
made on the right of the window.

 The values of check marks attached to images in versions before
DPP 4 are not maintained.
 You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

] as when the setting was

As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Setting Ratings in the Main Window

Sorting Images in the Main Window
You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [ ] marks) for each subject or theme.

Select the images you want to rate, and then click
any of the [ ].
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Attaching Check Marks in the Main Window
Select the images you want to attach a check mark
to, and then click any of [ ] to [ ].
Select
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Click (changes to [

] after clicking [

])

 The rating is set and an icon corresponding to the selected [ ]
appears in the image frame.
(Sample window shown with a rating of three [ ] as an example)
Click
 The selected check mark appears in the upper left of the image
frame.
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Check mark

Rating icon
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 Click the check mark again to remove the check marks.

 To cancel the rating, click the same [ ] as when the setting was
made.
 Set [Reject] with the [Label] menu or the quick check window
(p.31).
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To select multiple images in the main window

Viewing
Images

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.
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 The [Label] menu can also be used to attach check marks and set
ratings.
 You can display and change the rating settings set in DPP with other
EOS software and with any supported EOS DIGITAL camera (for the
EOS 7D, version 2.0.0 or later firmware) except the EOS-1D Mark IV,
EOS-1Ds Mark III, EOS-1D Mark III, EOS-1D Mark II N, EOS-1Ds
Mark II, EOS-1D Mark II, EOS-1D, EOS-1Ds, EOS 5D Mark II, EOS
5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D,
EOS D2000, EOS D6000, EOS D30, EOS D60, EOS REBEL T2i/
550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS
DIGITAL REBEL XS/1000D, EOS DIGITAL REBEL XTi/400D
DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, and EOS
DIGITAL REBEL/300D.
• EOS Utility version 2.9 or later:
Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.
• With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark IV, EOS-1Ds Mark III,
EOS-1D Mark III, EOS-1D Mark II N, EOS-1Ds Mark II, EOS-1D
Mark II, EOS-1D, EOS-1Ds, EOS 5D Mark II, EOS 5D, EOS 50D,
EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS
D2000, EOS D6000, EOS D30, EOS D60, EOS REBEL T2i/
550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D,
EOS DIGITAL REBEL XS/1000D, EOS DIGITAL REBEL XTi/
400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, and
EOS DIGITAL REBEL/300D:
Ratings set in DPP are displayed in the playback screen. You can
also change rating settings. However, you cannot display or
change settings for [Reject].
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 Reversely, you can also display and change in DPP the rating
settings set for images on any supported EOS DIGITAL camera
(for the EOS 7D, version 2.0.0 or later firmware) except the EOS1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS-1D Mark II
N, EOS-1Ds Mark II, EOS-1D Mark II, EOS-1D, EOS-1Ds, EOS
5D Mark II, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/
EOS 20Da, EOS 10D, EOS D2000, EOS D6000, EOS D30, EOS
D60, EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS
DIGITAL REBEL XSi/450D, EOS DIGITAL REBEL XS/1000D,
EOS DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL
XT/350D DIGITAL, and EOS DIGITAL REBEL/300D.
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Arranging Images in the Main Window
You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging Freely
Drag and drop the image to the desired location.

Sorting
Images

Arranging by Type

Editing
Images

Select the [Thumbnails] menu  [Sort]  desired item.
 The images are arranged in the order according to the selected
item.
Description
Images are sorted by file name in
alphanumeric order (0 to 9  A to Z).
Extension: ascending order Images are sorted in the following order:
RAW images  JPEG images  TIFF
images  MOV movies  MP4 movies.
Shooting Date/Time:
Images are sorted by shooting date and
ascending order
time from the earliest.
Check mark: ascending order Images with check marks take priority
and are sorted in number order.
Rating: ascending order
Sorted in order of fewest [ ].
Camera Model Name:
Sorted in order of least digit used in the
ascending order
camera model name. (Ex.: EOS-1D X 
EOS 6D)
Lens: ascending order
Sorted in order of shooting lens with
shortest focal length.
ISO speed: ascending order Sorted in order of lowest speed.
Shutter speed: ascending order Sorted in order of fastest shutter speed.
Aperture value: ascending order Sorted in order of lowest aperture value.
Focal length: ascending order Sorted in order of shooting lens with
shortest set focal length.

Printing
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Main sort items
File name: ascending order

* You can also arrange images by [Image Size], [RAW Type], and
[Recipe editing status].
* Descending order sorts all items in the reverse of ascending order.

Viewing
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 The image moves to the desired location.
 You can also select multiple images (p.35) and move them.
 The order of rearranged images is temporarily registered as
[Custom] in the [Filter/Sort pane] and maintained until you exit
DPP or select another folder in the folder area.
 Select the [Thumbnails] menu  [Sort]  [File name] and [Ascending]
to revert to the order before the images were rearranged.
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Maintaining the order of rearranged images
You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
 Maintain order without changing image file names
You can use the [View Settings] tab sheet in [Preferences] to maintain
the order of images without changing the image file names (p.178).
 Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.142).
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Displaying a RAW Image and JPEG Image as a Single Image
You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

 Images added to the [Collection] window
When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[
] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

Select the [Thumbnails] menu  [Group RAW and
JPG versions].
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 The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [
] mark (p.184).
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RAW images with the extension “.CR2” or “.CR3” can be
displayed as a single image

Processing
Large Numbers
of RAW Images

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2”, “.CR3”, and
JPEG images simultaneously. Images that have been simultaneously
shot with a camera that shoots RAW images with the extension “.CRW”
or “.TIF” cannot be displayed as a single image.
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Shooting

Playing Back
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When a single image is displayed
 Image displayed
The RAW image is displayed in all windows.
 Edited image
The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.
However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.
• Deleting an image (p.39)
• Moving or copying an image (p.39)
• Checkmarking (p.33, p.34)
• Rating (p.33, p.34)
• Rotating an image (p.13)
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If you cancel selection of [Group RAW and JPG versions], the RAW
image and JPEG image are displayed as separate images.

37

Checking Image Information
Select the image for which you want to check the
image information.

1
2 Select the [View] menu  [Info].
3 Select a tab sheet and check information.
 The image information window appears.

Image information window
[Exif Information]
tab sheet

[XMP/IPTC Information]
tab sheet

[Recipes]
tab sheet

 Shooting information is displayed in the [Exif Information] tab
sheet, while IPTC* information appended to the image after
shooting is displayed in the [XMP/IPTC Information] tab sheet.
IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [XMP/
IPTC Information] tab sheet.
* International Press Telecommunications Council (IPTC)
 The contents of the [Exif Information] tab sheet will vary
depending on the camera model.
 Recipe contents applied to an image are displayed in the
[Recipes] tab sheet.
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Convenient uses in the main window
 Switching displays
If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.
 Difference with the thumbnail with shooting information
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnails] menu  [With shooting info] (p.14).
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Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image
Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

1
2 Select the [File] menu  [Move to Recycle Bin].
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Moving Images
You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
 To move: Drag the image and release when the image is in the
destination folder.
 To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.
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 The image is moved to the [Recycle Bin] and is deleted from DPP.
 The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.
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 The images are moved or copied to the destination folder.
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Moving Images in Folders
You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
 To move: Drag the folder and release when the folder is in the
destination folder.
 To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)
You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

the folder for which a bookmark is to be
1 Select
registered.
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2 Select the [File] menu  [Bookmark].

 The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

 The folders are moved or copied to the destination folder.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].
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Select the [File] menu  [Remove bookmark].
 The selected folder is deleted from bookmarks.
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Editing Images

RAW Images ............................................................ 44
RAW Images.............................................................. 44
RAW Development .................................................... 44
When RAW Development is to be Done.................... 44
Advantages of a RAW Image .................................... 44
Editing JPEG and TIFF Images ............................... 45
Tool Palettes ............................................................ 46
JPEG/TIFF
Editing with the Basic Adjustment Tool
Palette ...................................................................... 48
Adjusting Brightness .................................................. 48
Changing the Picture Style ........................................ 49
Advanced Using a Picture Style File ............................. 51
Adjusting Color Tone by Changing White Balance.... 51
Adjusting Color Tone Using Click White Balance ...... 52

Editing with the Tone Adjustment Tool
Palette ..................................................................... 62
Adjusting Brightness and Contrast ............................. 62
Adjusting Color Tone Using Click White Balance....... 63
Advanced Adjusting Tone Curve ................................... 64
Example of a Tone Curve Operation ...................... 65
Advanced Adjusting Dynamic Range............................. 66
Using the Auto Lighting Optimizer .............................. 66
JPEG/TIFF Editing with the Color Adjustment Tool
Palette ..................................................................... 67

Adjusting White Balance with Color
Temperature .............................................................. 53
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68

Advanced

Tuning White Balance .................................. 53
Adjusting Contrast ..................................................... 54
Advanced

Adjusting Brightness of Shadows/
Highlights ................................................................... 54
Changing Color Tone and Color Saturation............... 55
Adjusting Monochrome .......................................... 55
Advanced

Adjusting Dynamic Range............................
Adjusting Gradation and Luminance Automatically ...
Using the Auto Lighting Optimizer .............................
Adjust Face Lighting ..................................................
Adjusting Image Sharpness.......................................
Detailed Setting of Image Sharpness ....................
Adjusting Clarity.........................................................
Advanced
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JPEG/TIFF

Editing with the Color Adjustment Tool
Palette ........................................................................
Adjusting a Specific Color Gamut...........................
Adjusting Hue and Saturation for an Entire
Image......................................................................
Adjusting in Monochrome .......................................
Advanced
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Editing with the Detailed Adjustment Tool
Palette ..................................................................... 69
Reducing Noise .......................................................... 69
Adjusting Image Sharpness........................................ 70
Reducing Color Moiré in an Image ............................. 70
JPEG/TIFF Editing with the Trimming/Angle Adjustment
Tool Palette ............................................................. 71
Editing with the Lens Correction Tool Palette.......... 74
Correcting Lens Aberration......................................... 74
Making Corrections..................................................... 75
JPEG/TIFF

Effects of Distortion Correction for Fisheye
Lenses .................................................................... 76
Shooting Distance Information Slider ......................... 77
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Correcting Multiple Images at a Time ........................
Digital Lens Optimizer................................................
Using the Digital Lens Optimizer ...............................
Adjusting Image Sharpness.......................................
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Editing with the Partial Adjustment
Tool Palette .............................................................. 82
JPEG/TIFF

Advanced

Making Partial Adjustments to Images ([Brightness],
[Contrast], [Hue], [Saturation]) ................................... 82
Making Partial Adjustments to Images ([Reduce color
moiré])........................................................................ 84
Adjustment Groups .................................................... 85

Editing with the Dust Delete/Copy Stamp
Tool Palette .............................................................. 86
Performing Automatic Dust Erasure Processing ....... 86
JPEG/TIFF

Automatic Dust Erasure Processing in the Main
Window ...................................................................... 87
Manually Erasing Dust (Repair Function) .................. 88
Erasing Unwanted Parts of an Image (Copy Stamp
Function).................................................................... 90

Setting Work Color Space........................................ 91
Using the Soft-Proof Colors Function....................... 92
Specifying the Size when Opening RAW Images .... 93
Displaying and Saving RAW Images ....................... 94
JPEG/TIFF Saving Editing Results.............................. 95
Saving Editing Contents to an Image ........................ 95
Saving as a separate image ...................................... 95
JPEG/TIFF Re-Editing an Image................................. 97
JPEG/TIFF
Utilizing Adjustment Contents (Recipe) .... 98

Copying a Recipe and Applying to Another Image..... 99
Saving a Recipe as a File........................................... 99
Loading and Applying Recipes ................................. 100

Adjusting by Comparing Multiple
Images................................................................... 101
JPEG/TIFF
Editing Efficiently ................................... 102
Editing in the Edit Image Window............................. 102
JPEG/TIFF

Changing the Thumbnail Display Position to
Horizontal ................................................................. 103
Gathering and Editing Images in the Collection
Window..................................................................... 104

Compositing Images .............................. 106
Compositing Methods............................................... 109
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Creating HDR (High Dynamic Range)
Images................................................................... 110
Advanced Using the Dual Pixel RAW Optimizer ........ 113
JPEG/TIFF

Microadjustment of the Position of Maximum Sharpness
and Resolution Using the Depth Information Contained
within the Dual Pixel RAW File ................................. 113
Reposition the Viewpoint or Foreground Bokeh
for a More Pleasing Result ....................................... 114
Reduces the Appearance of Ghosting in
Images...................................................................... 115

Using Depth Compositing.......... 117
Supported Images .................................................... 117
Using the Depth Compositing Tool........................... 117
Using the Depth Compositing Editing Tool............... 119
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Using the RAW Burst Image Tool ............. 122
Starting Up the RAW Burst Image Tool.................... 122
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Changing the Representative Image in a Roll ......... 124
Saving One Image in a Roll ..................................... 124
Extracting and Saving Any Range in a Roll ............. 125

Transferring a RAW Image to
Photoshop .............................................................. 126
Advanced Customizing the Main Window Toolbar ..... 127
Advanced Using Cloud Processing ............................ 128
Supported Images ................................................... 128
Requirements for Using this Function...................... 128
Enabling Cloud Processing...................................... 128
Cloud Processing and CIP Image Editing................ 129
Using Noise Reduction (Cloud) ............................... 130
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* Sections with JPEG/TIFF and JPEG/TIFF in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image
editing.
JPEG/TIFF
JPEG/TIFF

: All the functions explained in the section support
JPEG/TIFF image editing.
: Certain functions explained in the section support
JPEG/TIFF image editing.
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RAW Images
RAW Images
A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.
* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development
If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).
With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on
your computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called
“development”.

Advantages of a RAW Image
RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.
Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.98).
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When RAW Development is to be Done
DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.
With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.
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RAW image data
Image processing conditions information
Contents adjusted using the tool
palettes can be handled
individually as a recipe file
(extension “.dr4”) (p.98, p.99).
In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.99), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.100). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.
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Editing JPEG and TIFF Images
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With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.
• Tone Adjustment tool palette
• Color Adjustment tool palette
• Detailed Adjustment tool palette
• Trimming/Angle Adjustment tool palette
• Partial Adjustment tool palette
• Dust Delete/Copy Stamp tool palette
• Settings tool palette
Because adjustments made with these tool palettes (the recipe) only
change the image processing conditions, the “original image data itself”
remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.
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JPEG, TIFF image data
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Image processing conditions information

HDR PQ
Mode

Contents adjusted using the tool
palettes can be handled
individually as a recipe file
(extension “.dr4”) (p.98, p.99).
In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.99), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.100). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.
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You can also adjust HEIF images in DPP in the same way as JPEG/
TIFF images.
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Tool Palettes
With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only
change the image processing conditions, the “original image data itself”
remains unaffected. As there is no image deterioration that normally
accompanies editing, you can readjust your image any number of times.
The various functions of the tool palettes are explained in more detail
under the respective topics.
Trimming/Angle
Adjustment tool
palette

Partial
Adjustment tool
palette

Lens
Correction tool
palette

 Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.48).

 Tone Adjustment tool palette
Adjusts the tone curve and applies the Auto Lighting Optimizer (p.62).

 Color Adjustment tool palette
Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.67).

 Detailed Adjustment tool palette
Reduces noise and adjusts the image sharpness (p.69).

 Trimming/Angle Adjustment tool palette
Crops an image and adjusts the image angle (p.71).

 Lens Correction tool palette
Corrects lens aberration in the image (p.74) and applies the Digital
Lens Optimizer (p.79).

Basic
Adjustment
tool palette

Dust Delete/
Copy Stamp
tool palette

 Partial Adjustment tool palette

Detailed
Adjustment
tool palette

Settings tool
palette

 Dust Delete/Copy Stamp tool palette

Color
Adjustment
tool palette

 Settings tool palette

Tone
Adjustment
tool palette
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Adjusts the selected area of an image (p.82).
Erases dust from an image and corrects image by copying sections
of the image (p.86).
Configures settings such as the work color space (p.91).
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Using the different tool palettes
We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.62), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.69) and lens aberration correction (p.75), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.69) and Lens Correction tool palette (p.74).
 You can click the [
] button at the bottom right of the main window
to show/hide [Tool palette].
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JPEG/TIFF

Editing with the Basic Adjustment Tool Palette
The Basic Adjustment tool palette makes basic adjustments to RAW
images. With this tool palette, you can adjust the image brightness, set
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.
Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness.
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Adjusting Brightness
The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.
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1 Select an image in the main window, etc.
2 Display the Basic Adjustment tool palette.

Reverts the image to
the original settings
Enter a numerical
value

Drag the slider left or right
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The adjustment range is –3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Picture Style

Changing the Picture Style
If the image looks different from what you visualized at the time of
shooting, you can get it closer to what you expected by changing the
Picture Style. Even if you have saved the image (p.95) with
[Monochrome] (p.55) selected, you can still change to another Picture
Style at any point by simply selecting a Picture Style other than
[Monochrome].
Reverts the image to
the original settings

()

Description
The Picture Style set with the camera when the
image was shot.
When a mode in the Creative Zone is selected on the
camera, the Picture Style set is displayed in ( ).
When a mode in the Basic Zone is selected on the
camera, [Shot settings] is displayed in ( ), and image
characteristics that are according to the selected
shooting mode are applied.

Standard

The image looks vivid.
Generally, this setting is suitable for most images.

Auto

The color tone will be adjusted to suit the scene.
The colors will look vivid. Especially the colors of
blue skies, greenery, and sunsets will be vivid in a
shot of nature, outdoor, or sunset scenes.

Portrait

For nice skin tones.
Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.55).

Select
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Landscape

For vivid blues and greens.
Effective for making images of landscapes
impressive.

Playing Back
Movies and Saving
Still Photos

Fine Detail

Suited for detailed outline and fine texture
description of the subject. The colors will be slightly
vivid.

Handling
RAW Movies

Neutral

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

Faithful

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

Monochrome

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.55).

HDR PQ
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Picture Style

Description

Viewing
Images

Displayed when selecting an image shot with the
(Picture Style file
Picture Style file registered in the camera.
registered in the
In the list, the name of the Picture Style file is
camera)
displayed in ( ).
[Picture Style file The name of the Picture Style file applied in DPP is
applied in DPP] displayed in [ ].

Sorting
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 You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.
 [Auto] is not applied to images shot with the EOS-1D Mark IV,
EOS-1Ds Mark III, EOS-1D Mark III, EOS-1D Mark II N, EOS-1Ds
Mark II, EOS-1D Mark II, EOS-1D, EOS-1Ds, EOS 5D Mark II,
EOS 5D, EOS 7D, EOS 60D/EOS 60Da, EOS 50D, EOS 40D,
EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000, EOS
D6000, EOS D30, EOS D60, EOS REBEL T2i/550D, EOS
REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS
DIGITAL REBEL XS/1000D, EOS REBEL T3/1100D, EOS
DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/
350D DIGITAL, EOS DIGITAL REBEL/300D, PowerShot G3 X,
PowerShot G1 X Mark II, PowerShot G7 X, PowerShot G9 X,
PowerShot SX60 HS, PowerShot G5 X, PowerShot G16,
PowerShot S120, PowerShot G1 X, PowerShot G15, PowerShot
S110, PowerShot S100, PowerShot G9, PowerShot G10,
PowerShot G11, PowerShot G12, PowerShot S90, PowerShot
S95, PowerShot SX1 IS, PowerShot SX50 HS, or PowerShot
SX70 HS. When changing the Picture Style with several images
selected, although you can select [Auto] if images shot with any
supported camera other than the above are included, [Auto] will
not be applied to the images shot with the above cameras.
 You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark II, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S120,
PowerShot G1 X, PowerShot G15, PowerShot S110, PowerShot
S100, PowerShot G9, PowerShot G10, PowerShot G11,
PowerShot G12, PowerShot S90, PowerShot S95, PowerShot
SX1 IS, and PowerShot SX50 HS.
 You cannot select [Auto] with multiple-exposure RAW images
created with the camera.
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Advanced

Using a Picture Style File
A Picture Style file is a Picture Style extension file.
With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon Web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Adjusting Color Tone by Changing White Balance
If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Printing
Images

Reverts the image to
the original settings
Select


a Picture Style file saved on your computer,
2 Select
and click the [Open] button.

 The Picture Style file you selected is applied to an image.
 To apply a different Picture Style file, follow the procedure from
step 2 again.

( ) is the white balance set on the camera when the image was shot.
• When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ( ).
• When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in ( ), and image characteristics that
are according to the selected shooting mode are applied.

The color tone does not become more natural even when the
white balance is changed
If the color tone of the image does not appear natural after changing the
white balance, adjust the white balance using click white balance (p.52).
Tune with color tone
To make further fine adjustments to color tone after adjusting the white
balance, you can use [Color tone] (p.55) for tuning towards your expectations.
 You cannot register the adjustment results as personal white
balance (p.137) when you have selected [ ( )] from the list box.
 You cannot change or adjust white balance with multipleexposure RAW images created on the camera.

The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.
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1 Click the [Browse] button in the [Picture Style] panel.

 The [Open] dialog box appears.
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Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance
You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

 The color of the image is adjusted with the point you selected as
the standard for white.
 If you click on another point in the image, the white balance is
adjusted again.
 To finish click white balance, right-click with the mouse or click
the [
] button again.

1

Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Click

2
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Click on a point that is to be the standard for white.
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When there are no white areas in your image

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

Reverts the
image to the
original settings

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.
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You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Advanced

Advanced

Adjusting White Balance with Color Temperature

Tuning White Balance

White balance can be adjusted by setting a numerical value for color
temperature.

[Color temperature] from the [White balance
1 Select
adjustment] list box.
2 Set the color temperature.

Viewing
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This is a function that makes fine adjustments to the white balance.
Using this function, you can achieve the same effects as third-party
color temperature conversion filters and color correction filters. The
adjustable range is ±10 steps. This function is aimed particularly at highend users who are familiar with the roles and effects of color
temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

Enter the values to set
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Displays the value of
the setting
Drag the slider left or right

Drag the sliders left
or right
 B stands for blue, A for amber, M for magenta and G for green.
The color is adjusted towards the color to which the point moves.
 You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.
Drag

 To register the adjustment outcomes as a personal white balance
(p.137), select a setting other than [ ( )] from the [White
balance adjustment] list box before tuning the white balance. If
you selected [ ( )] from the list box and tuned the white
balance, you cannot then register the outcomes as a personal
white balance.
 You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

The adjustment range is 2000 to 10000K (in 10K increments).

The adjustable range is 0 to ±10. (in 0.1-stop increments when
entering a value).
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Adjusting Contrast

Advanced

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Adjusting Brightness of Shadows/Highlights
You can adjust the brightness of shadows and highlights in an image.
By adjusting only shadows or highlights in an image, you can reduce the
effects of clipping in shadows and highlights.

Reverts the image to
the original settings
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Drag the slider left or
right (9 steps)
Enter a setting (in 0.1stop increments)

Drag the sliders left
or right
Enter a setting (in 0.1stop increments)
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If you make a major adjustment to the highlights or shadows in an
image, the image may look unnatural. In such a case, reduce the
degree of adjustment.
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Changing Color Tone and Color Saturation
Tone and overall color saturation can be adjusted.
If Picture Style (p.49) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).
Reverts the image to
the original settings

Adjusting Monochrome
When the Picture Style (p.49) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering, or with a look
of monotone color photograph.

1 Select [Monochrome] in the [Picture Style] list box.
2

Reverts the image to
the original settings
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Drag the sliders left or
right
Enter a setting (in 0.1stop increments)
 Color tone:

Move the slider to the right to make tones
more yellowish, and to the left to make tones
more reddish.
 Color saturation: Adjusts the overall color intensity for the
image. Move the slider to the right for more
intense colors, and to the left for less intense
colors.

The adjustment range is –4 to +4.
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Displays the values of
the settings
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 Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.
Filter

Example of effect

None

General monochrome image without filter effect.

Yellow

Blue sky is reproduced more naturally and white
clouds emerge clearly.

Orange

Blue sky becomes somewhat darker. The
brightness of the setting sun increases further.

Red

Blue sky becomes quite dark. Autumn leaves
become clear and bright.

Green

Advanced

Viewing
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Adjusting Dynamic Range
Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.
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Move downwards
Output white points
Move to the left or right
Input white points
Move to the left or right
Mid (medium tone) point

Human skin tones and lips become softer. The
green leaves of trees become clear and bright.

 Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Move upwards
Output black points
You can also adjust
the dynamic range by
entering values
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Move to the left or right
Input black points
 The horizontal axis shows the input level and the vertical axis
shows the output level.
 Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input
black points.
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Increase the [Contrast] to emphasize the filter effect
To emphasize the filter effect, set the [Contrast] slider to the right.
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[Linear] - A function for advanced adjustment
Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.
[Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.58) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically
In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

 White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
 Settings that are reset and those that are not with this adjustment
are as follows.
Settings that are reset
・Auto Lighting Optimizer
・[Contrast] in the [Advanced] panel
Settings

that are not reset

・Brightness adjustment
・White balance adjustment
・Linear*
* White points and black points are automatically adjusted.
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 In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.
An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.
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Using the Auto Lighting Optimizer

Viewing
Images

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.
You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.
This function also can be used for JPEG/TIFF images in addition to
RAW images.
* ALO stands for Auto Lighting Optimizer.

1
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Checkmark the [Auto Lighting Optimizer] checkbox.

Processing
Large Numbers
of RAW Images

Checkmark

 For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Remote
Shooting

2 Change the setting according to your preferences.
Select from three
levels: Low/Standard/
Strong
 Auto correction is applied to the image to match the setting.
 For the image shot with the camera’s Auto Lighting Optimizer
function, the setting at the time of shooting is applied as the
default value.
 To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.
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 When [Highlight tone priority] is set to [Enable] on any supported
EOS DIGITAL camera other than the EOS-1D Mark IV or EOS 5D
Mark II, the Auto Lighting Optimizer cannot be used for RAW
images.
 You cannot use the Auto Lighting Optimizer with multipleexposure RAW images created with the camera.
 When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.

Specifying
Preferences

58

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

Adjust Face Lighting
With adjust face lighting, you can automatically optimize facial lighting
and effectively correct a face that is illuminated at an angle or by a flash.
This function can be enabled when the Auto Lighting Optimizer is used.
Use this function with RAW images from images of people shot with an
EOS R5 or EOS R6.

Select a supported image in the main window, etc.

1
2 Checkmark the [Adj face lighting] checkbox.

Checkmark
 The image is corrected.

Adjusting Image Sharpness
You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].
[Sharpness]:

Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.
[Unsharp mask]: Adjusts the image’s sharpness more finely.
[Strength]:
Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.
[Fineness]:
Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.
[Threshold]: Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.
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 You might not be able to checkmark the Adj face lighting
checkbox for images such as where facial details cannot be
discerned or a face is too dark.
 Noise may increase.
 Adjustment may be less effective at high ISO speeds.

[Unsharp mask] cannot be used with images other than RAW
images.
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Select [Sharpness] from the list box and adjust the
setting.
Reverts the image to
the original settings

Detailed Setting of Image Sharpness
Select [Unsharp mask] from the list box and adjust
the setting.
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Select [Sharpness]
Enter a setting (in 0.1stop increments)
Drag the slider left or right

Handling
RAW Movies

Select [Unsharp mask]
Enter a setting (in
0.1-stop increments)
Drag the slider left
or right

The adjustment range is 0 to 10.

Adjust image sharpness with the window view set to [400%], [200%]
or [100%]. If the view is set to [Fit to window] (full view), you may not
be able to correctly check the adjustment results.

HDR PQ
Mode

Specifying
Preferences

60

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

Adjusting Clarity
This function allows you to change the contrast at the edges of an
image. It can be used with images shot on a camera model that allows
clarity to be set on the camera.

1 Select an image to adjust in the main window, etc.
the Basic Adjustment tool palette and adjust
2 Display
the image.
Reverts the image to
the original settings

Drag the slider left or right

Enter a numerical
value

 The further the slider is moved to the right, the more clarity the
image has.
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The adjustment range is -4 to +4.
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Editing with the Tone Adjustment Tool Palette
With the Tone Adjustment tool palette, you can adjust images with the
same functions as general image editing software.

1 Select an image in the main window, etc.
2 Display the Tone Adjustment tool palette.
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Adjusting Brightness and Contrast
The brightness and contrast of an image can be adjusted. Since the
adjustment range is broader than the same functions in the Basic
Adjustment tool palette, the image color may be saturated, or the image
quality may deteriorate if you adjust too much. Be especially careful
when adjusting.
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Reverts the image to
the original settings
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Drag the sliders left or
right
Enter a setting (in 0.1stop increments)
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 Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.
 Contrast: Used to adjust modulation and degree of contrast
of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

Adjusting Color Tone Using Click White Balance
You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

1 Click the [

] button.
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The adjustment range is –100 to +100 (in 0.1-stop increments when
entering a value).
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2

Click on a point that is to be the standard for white.

Advanced

Adjusting Tone Curve
You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.185).

the tone curve mode and interpolation
1 Select
method.
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Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)
 The color of the image is adjusted with the point you selected as
the standard for white.
 If you click on another point in the image, the white balance is
adjusted again.
 To finish click white balance, right-click with the mouse or click
the [
] button again.
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When there are no white areas in your image
When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.
The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.
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2

Example of a Tone Curve Operation

Make adjustments.

Makes medium tones brighter

Makes medium tones darker
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RGB: Adjusts RGB
in a batch
R, G, B: Adjusts
each channel
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You can display preand post-adjustment
histograms
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Makes tones sharper

Makes tones softer

Remote
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Coordinates of [ ]
(when several
coordinates are set,
coordinates of lastset [ ])
 The horizontal axis shows the input level and the vertical axis
shows the output level.
 The maximum number of [ ] is 8.
 To delete a [ ], either press the <Del> key or double-click on the [ ].
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Advanced

Adjusting Dynamic Range
Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.
Move downwards
Output white points

Using the Auto Lighting Optimizer
Reverts the
image to the
original
settings

Move to the
right
Input black
points

 The setting range of black points is 0 to 247 (in 1-stop increments
when entering a value).
 The setting range of white points is 8 to 255 (in 1-stop increments
when entering a value).
 You can display pre- and post-editing histograms (p.65).

Move to the
left
Input white
points

For information on using the Auto Lighting Optimizer, see “Using the
Auto Lighting Optimizer” (p.58) in “Editing with the Basic Adjustment
Tool Palette”.
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Move upwards
Output black points

Output
white point
numerical
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 The horizontal axis shows the input level and the vertical axis shows
the output level.
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JPEG/TIFF

Editing with the Color Adjustment Tool Palette
With the Color Adjustment tool palette, you can adjust the hue,
saturation and luminance in a specific color gamut for 8 color gamuts
(red, orange, yellow, green, aqua, blue, purple and magenta). You can
also adjust the hue and saturation for the entire image and tune
monochrome images.

Select an image in the main window, etc.

1
2 Display the Color Adjustment tool palette.
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Editing with the Color Adjustment Tool Palette
Adjusting a Specific Color Gamut
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.
H: Adjusts the hue.
S: Adjusts the saturation.
L: Adjusts the luminosity.

Revert all adjustments to
the original settings

Drag the sliders left
or right
Enter the values to set
Revert color gamut
adjustments to the
original settings
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The adjustment ranges are as follows:
H: –20 to +20
S: –10 to +10
L: –10 to +10
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Adjusting Hue and Saturation for an Entire
Image
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.
 Hue:
Move the slider to the right to make color tones more
yellowish, and to the left to make color tones more reddish.
 Saturation:Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for
less intense colors.

Revert all adjustments
to the original settings
Enter the values to set
Drag the sliders left or
right

Adjusting in Monochrome
Press the [Monochrome] button to set the 8 color gamuts to their least
saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.
Drag the sliders left or
right
Revert all adjustments
to the original settings
Enter the values to set
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The adjustment range for hue is –30 to +30; and for saturation is 0
to 200.

68

JPEG/TIFF

Editing with the Detailed Adjustment Tool Palette
You can use the Detailed Adjustment tool palette to reduce the noise
that occurs in images shot at night or at high ISO settings. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that you can use the functions in this tool palette with
JPEG and TIFF images as well as RAW images.

1 Select an image in the main window, etc.
2 Display the Detailed Adjustment tool palette.
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Reducing Noise
You can reduce noise that arises in images shot at night or with a high
ISO speed.
* NR stands for Noise Reduction.

Adjust an image.
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Drag the sliders
Enter a setting (in 0.1stop increments)
 You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.
 The noise reduction effect can also be checked in the check
window.
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Setting the same noise reduction level for several images
You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.
 If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
 If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Reducing Color Moiré in an Image
You can reduce color moiré* occurring in an image.
*Color moiré: Occurrence of a color appearing that is not originally in an
image. In particular, tends to occur when taking photos of latticed or
similar patterns.

Checkmark the [Reduce color moiré] checkbox and
adjust using the slider.
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Adjusting Image Sharpness
You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.59).
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 Depending on the subject, you may not be able to correct color
moiré completely.
 Using this function may cause hue to change depending on the
subject. If there is a noticeable change in hue, lower the level of
adjustment.
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JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette
You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before cropping.

1 Select the image to be cropped.
2 Display the Trimming/Angle Adjustment tool palette.
 You cannot make adjustments with the Trimming/Angle
Adjustment tool palette in a window that only shows thumbnails.

3

Adjust the angle of the image as needed.
Trimming/angle adjustment window

 If you click [Center on Screen], you can display the trimming
range in the center of the window.
 When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image.
 If you have only adjusted the angle of the image, the image will
be cropped at the largest possible trimming range.

4 Select a ratio and drag the trimming range.
Select a trimming ratio
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Drag the trimming
range

Drag (0.01-degree increments; adjustment range: –45 to +45
degrees)

 The trimming range can be moved by dragging.
 You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.
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Use the mouse (click /) to adjust the angle or directly enter
the adjustment angle (0.01-degree increments; adjustable
range: –45 to +45 degrees)
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When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark II, the displayed
trimming range is based on the aspect ratio information.
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 List of aspect ratios (width : height)

[Free]:

You can crop an image to any size, regardless of
the selectable ratio.
[Custom]: You can crop an image at the specified ratio.

5

Return to the main window.
 The trimming range frame is displayed in the cropped image
(p.184).
 When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

Cropped images
 The trimmed range can be reverted to its original condition at
any time
A cropped image is displayed or printed as a cropped image.
However, since the image is not actually cropped, you can always
revert to the original image by clicking the [
] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.97).
 Display of the cropped image in each window
• Main window:
The frame showing the trimming range is
displayed on the image (p.184).
• Preview window:
The image is displayed in its cropped condition.
• Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.
 Printing a cropped image
You can print as a cropped image by printing it in DPP.
 The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.95).
 Images that have aspect ratio set will be displayed as cropped
images
When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
II, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.*
When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [
] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EOS 5DS R, EOS 5D Mark IV, EOS
5D Mark III, EOS R5/R6/R/Ra/RP (with any setting other than [1.6x
(crop)]), or EOS 7D Mark II and [Add cropping information] is set in
Custom Functions, aspect ratio information is only set and the
image is not actually cropped, even for JPEG images.
 Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.
 Apply the trimmed range to another image
You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.
To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.
To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.
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For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette
With the Lens Correction tool palette, you can use the lens aberration
correction functions and the Digital Lens Optimizer to correct lens
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

1 Select an image in the main window, etc.
2 Display the Lens Correction tool palette.

Correcting Lens Aberration
You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.
You can only correct aberration in RAW images which have been shot
with compatible lenses. JPEG or TIFF images cannot be corrected.
Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D6000, EOS D30, EOS D60, EOS DIGITAL REBEL XT/350D
DIGITAL, and EOS DIGITAL REBEL/300D are EOS DIGITAL cameras
supporting the Digital Photo Professional, they are not compatible with
the lens aberration correction function. Also, note that the lens
aberration correction function is compatible with the EOS 5D with the
firmware version 1.1.1 and the EOS 30D with the firmware version
1.0.6.
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To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.
 Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.80).
 You can also correct RAW images taken with the compatible lens
even when the extender is attached.
 You can also correct RAW images shot with EF50mm f/2.5
Compact Macro fitted with Life Size Converter EF.
 The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
 The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
 EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections
You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.
 Peripheral illumination
 Chromatic aberration (color fringing which occurs in the periphery of
an image)
 Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
 Distortions
Diffraction

Select an image in the main window.

1
the Lens Correction tool palette and
2 Display
checkmark the items to be corrected.
Enlargement display section

 The image is corrected and redisplayed.
 In the main window, the [ ] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.184).

 Check the results of corrections to peripheral illumination or
distortions in the full view.
 Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.
 You can lessen the degree of correction by moving the slider to
the left.
 You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.
 To correct distortion aberration of images shot with a fisheye lens
(EF8–15mm f/4L USM Fisheye or EF15mm f/2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.
The level of an effect can be adjusted with the adjustment slider
located below [Distortion].
For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.76).
 For images shot with EF8–15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.
Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.
 When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
 [Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera’s
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.
 The adjustment range of distortion correction is either [0 to +100]
or [–20 to +120], depending on the camera model that was used
for shooting. The adjustment range for images shot with a
fisheye lens mounted is [0 to +100] regardless of the camera
model that was used.
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Effects of Distortion Correction for Fisheye
Lenses
 Shot settings
By selecting this option, only the aberration corrections will be
performed to correct the optical distortions.

 Emphasize Distance
This converts the image to an “equidistant projection” style image.
This projection method preserves distance relationships.
Equidistant projection displays a distance in the same distance
anywhere from the center to the periphery. In particular, when
shooting a celestial body such as the celestial sphere, same heights
above the horizon(declination) are captured at the same heights. This
method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.).
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 Emphasize Linearity
This converts the image to a “central projection” style image. This
projection method is employed for general lenses.
Since central projection displays straight lines as straight lines, a
wide-view panoramic image can be obtained by selecting this option.
However, the periphery is stretched, resulting in decreased resolution.

Remote
Shooting

 Emphasize Periphery
This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.
Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.
By selecting this option, the periphery is stretched and may result in
decreased resolution.
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 Emphasize Center
This converts the image to an “orthographic projection” style image.
With this projection method, the center is more emphasized.
Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

Shooting Distance Information Slider
 When correcting RAW images and if shooting distance information has
been saved to the image, the slider is set automatically according to
this shooting distance information. However, if no shooting distance
information is saved to the image, the slider is set automatically to the
right end at infinity position and a [<!>] appears above the slider.
If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.
 When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.
EOS-1D Mark II N
EOS-1D
EOS 30D

EOS-1Ds Mark II
EOS-1D Mark II
EOS-1Ds
EOS 5D
EOS DIGITAL REBEL
XTi/400D DIGITAL

 For RAW images shot with MP-E65mm f/2.8 1-5x Macro Photo or
EF50mm f/2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].
 The [Shooting distance information] slider is applied to all the
correction items with check marks.
 If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.
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When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection
method. However, the conversion does not really apply a change of
projection method in a strict sense.
Accordingly, be aware that they are not suited for scientific or other
such purposes.
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Correcting Multiple Images at a Time
You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.75).
Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.99).
Additional information
 Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]
You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.69). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.
 The image appears with less resolution after correcting
[Distortion]
You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.70).
 The colors of the image became weaker after correcting [Color
blur]
You can make the image similar to the one before correction by
adjusting the color tone (p.55) and/or the color saturation (p.68) to
make the color deeper.
 The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur
which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer
This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.74). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data]
for the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended
that you set [Sharpness] or [Strength] for [Unsharp mask] for images to
0.
Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D6000, EOS D30, EOS D60, EOS DIGITAL REBEL XT/350D
DIGITAL, and EOS DIGITAL REBEL/300D are EOS DIGITAL cameras
supporting the Digital Photo Professional, they are not compatible with
the Digital Lens Optimizer. Also, note that the Digital Lens Optimizer is
compatible with the EOS 5D with the firmware version 1.1.1 and the
EOS 30D with the firmware version 1.0.6.
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 To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
 The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
 You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
 EF cinema lenses (CN-E lenses) are not compatible.
 [Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.
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Using the Digital Lens Optimizer

2 Click the [

] button.

the status of [Lens data] for [Digital Lens
1 Check
Optimizer].
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 The [Add or Remove lens data] window appears.
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 [Not Available] is displayed for an image shot with a noncompatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.
 If [No] is displayed, proceed to step 2. To use the function, you
need to download the lens data for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the image information and shooting information displays.
You can also check it with the menu that appears when you rightclick with the mouse on an image.
 If [Yes] is displayed, proceed to step 4.
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To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.
Before you click the [
] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images.
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the checkbox for the lens used to shoot
3 Checkmark
the image, and click the [Start] button.

the [Digital Lens Optimizer] checkbox
4 Checkmark
and adjust the image.
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Reverts to its condition
before adjustment
 The lens data is downloaded to your computer.
 When the downloading of the lens data ends, the indication for
the lens data changes to [Yes].
 Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window.
 If you remove the check mark from the checkbox for alreadydownloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.
 Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.
 If you want to change the destination where lens data is saved
when there is already downloaded lens data, move the previously
downloaded lens data from the old folder to the new destination
folder manually.
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Since the lens data downloaded with DPP version 3.x is not
compatible with DPP version 4.x, the lens data must be downloaded
again.
When applying the Digital Lens Optimizer, the effect of [Sharpness]
or [Unsharp mask] may become excessive. It is recommended that
you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0
before using the Digital Lens Optimizer. Adjust [Sharpness] or
[Unsharp mask] again after applying the Digital Lens Optimizer to
images.
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 Use the slider to adjust the Digital Lens Optimizer effect.
 If no shooting distance information is saved to the image, the
shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance
slider.
 If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.
 Images cannot be corrected for [Chromatic aberration] in the lens
aberration correction tool pallet if the Digital Lens Optimizer has
been applied.
 In the main window, the [
] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.184).

Adjusting Image Sharpness
You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.59).
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JPEG/TIFF

Advanced

Editing with the Partial Adjustment Tool Palette
The Partial Adjustment tool palette adjusts the selected area of an
image.
With this tool palette, you can adjust brightness, contrast, hue, and
saturation, and reduce color moiré.
Supported image formats are CR2, CR3, TIFF, and JPG.

3

Select [Adjustment group].
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Making Partial Adjustments to Images
([Brightness], [Contrast], [Hue], [Saturation])

Editing
Images

1 Select an image in the main window, etc.
2 Display the Partial Adjustment tool palette.
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 Select [Adjustment group] from [
], [
], [
], [
], and
[
].
(By default, [
] is selected.)
For information on adjustment groups, see “Adjustment Groups”
(p.85).

4 Click the [Set Adjustment Area] button.
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 A circular cursor appears in the window.
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Click or drag the circular cursor on the image to
select the area of adjustment in the image.

6
the sliders to adjust [Adjustment items] as
7 Use
necessary.
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Circular cursor

the sliders to adjust [Size] and [Blur radius] for
5 Drag
the circular cursor.

 Adjustments are applied to the area selected in step 6.
 You can use the [
], [
], [
], and [
]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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 [Blur radius] adjusts blurring at the border of the selected area.

83

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

Making Partial Adjustments to Images
([Reduce color moiré])
This function partially reduces color moiré in images.
Before making adjustments, see “Reducing Color Moiré in an Image”
(p.70) for information on reducing color moiré.

Select an image in the main window, etc.

1
2 Display the Partial Adjustment tool palette.
the [Reduce color moiré] button in [Adjustment
3 Click
group].
 A dialog box for [Reduce color moiré] appears.

the [Set Adjustment Area] button, and use the
4 Click
[Size] and [Blur radius] sliders for the circular cursor
to make adjustments.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

5
the [Reduce color moiré] slider in [Adjustment
6 Use
items] to specify the setting.
 Changes edited with this function are not displayed in the
following images.
• Thumbnail images
• Navigator images
• Images in the HDR [Select images] window (see p.110, step 3)
• Images in the [Contact sheet] window for printing a thumbnail
list (see p.134, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
 Changes edited with this function are not applied in the DPP
histogram display.

 Adjustments are applied to the area selected in step 5.
 You can use the [
], [
], [
], and [
]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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 The Partial Adjustment tool palette comprises 5 adjustment groups
that allow adjustments to be made with [Brightness], [Contrast], [Hue],
and [Saturation] options, and 1 adjustment group that allows
adjustments to be made with the [Reduce color moiré] option.
• A different adjustment area can be selected for each adjustment
group.
• Adjustment groups [
], [
], [
], [
], and [
] allow
different values to be specified even for a same adjustment option.
 By default, adjustments from all adjustment groups are applied to an
image. However, you can click the [ ] button and select to apply or
not apply adjustments from each adjustment group.
 Positions selected with the circular cursor, that can be checked using
the [
], [
], [
], and [
] buttons below
[Adjustment items], can be checked per each group.
 The order of adjustment groups in which adjustments are applied to
images is (1) [Reduce color moiré], (2) [
], (3) [
], (4) [
],
(5) [
], and (6) [
].

 Changes edited with this function are not displayed in the
following images.
• Thumbnail images
• Navigator images
• Images in the HDR [Select images] window (see p.110, step 3)
• Images in the [Contact sheet] window for printing a thumbnail
list (see p.134, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
 Changes edited with this function are not applied in the DPP
histogram display.
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette
You can use this tool palette to erase dust and other marks in a shot
image and to correct an image by copying part of the image and pasting
it onto an unnecessary part of the image.
Note that you can use the functions in this tool palette with JPEG and
TIFF images as well as RAW images.

Dust Delete/Copy Stamp Tool Palette

Performing Automatic Dust Erasure Processing
The Dust Delete Data that is appended to images can be used to
automatically erase dust spots.

an image with dust delete data attached in the
1 Select
main window, etc.
2 Display the Dust Delete/Copy Stamp tool palette.
 You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails.

the image has redrawn itself, click the [Apply
3 When
Dust Delete Data] button.
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 Dust spots are erased in a single operation.

4

Return to the main window.
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Additional information
 The dust-erased image can be reverted to its original condition
at any time
A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [
] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.97).
 Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.
 To erase dust spots that cannot be erased with the automatic
dust erasure processing
In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.88) or the copy stamp function (p.90).
 The image becomes a dust-erased image when converted and
saved
The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.95).
 Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window
In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu 
[Apply Dust Delete Data].
 Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)
You can erase dust spots in an image by selecting them one by one.

5

Place the dust spot to be erased within the [ ] and
click.

window, select the image from which you
1 Inwantthetomain
erase dust spots.
2 Display the Dust Delete/Copy Stamp tool palette.
3 Click the point from where dust is to be erased.
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Click

Click
 The display changes to 100% view.
 The display position can be changed by dragging.

the button that matches the dust spot to be
4 Click
erased.

 If the dust spot is dark in color, click the [
] button,
and if the dust spot is light in color, click the [
]
button.
 When you move the cursor over the image, the dust erasure
range is indicated with [ ].

Viewing
Images

 The dust spot within the [ ] is erased.
 Click on another part of the image to continue erasing dust spots
within the displayed image.
 To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
 When the dust spot cannot be erased, [ ] is displayed.

6 Return to the main window.
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Additional information
 Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.
 Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.90).
 The dust-erased image can be reverted to its original condition
at any time
A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [
] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.97).
 Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.
 The image becomes a dust-erased image when converted and
saved
The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.95).

Useful functions of the copy stamp window
 Switch between full screen display/normal screen display using
shortcut keys
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.
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For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)
You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.88).

1
2 Specify the section to be copied.

 Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.
 To change the section that is to be the copy source, perform the
operation above again.
 To fix the position of the copy source, checkmark [Fix Copy
Source position].

3 Correct the image.

 Click or drag on the part of the image you want to modify. [+] in
the window indicates the copy source and [ ] indicates the copy
destination.
 The copied image is pasted in the position to which it was
dragged.
 For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

4 Return to the main window.
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Setting Work Color Space
A different work color space (p.177) from the default settings (p.186) can
be set for each image.

Display the Settings tool palette  select the color
space to be set.
Settings tool palette
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A color space set individually does not change even when the
default setting is changed
If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.177), this
default setting will not be applied and the individually set color space will
remain.
The color space of a RAW image can be changed freely as
many times as required
Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function
By using the soft-proof colors function, you can apply a selected printing
profile or CMYK simulation profile to the displayed image. The reliability
of the soft-proof colors function depends on the monitor quality, the
monitor and printer profiles, and surrounding lighting conditions where
you are working.

3
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According to the profile selected in step 2, select
either [Use printing profile] or [Use CMYK simulation
profile], and checkmark the [Soft-proof colors]
checkbox.
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1 Click the [Settings] button.
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 The [Color management] tab sheet in [Preferences] appears.

the profile to apply from the [Printing profile]
2 Select
or [CMYK simulation profile] list box, and click the
[OK] button.

 The profile selected in step 2 is applied to the displayed image
including its thumbnail.
The profile is not applied to images displayed in the quick check
window.
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 The [Color management] tab sheet in [Preferences] closes.
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Specifying the Size when Opening RAW Images
This applies only to RAW images with the extension “.CR3” that were
shot with [
] selected on the camera.
This function specifies the image size when a RAW image is selected
and opened in DPP. When the selected RAW image is converted and
saved as a JPEG or TIFF image, it is also saved at the same size. This
function is not available for images shot with the Dual Pixel RAW
function set on the camera.

Select the RAW image  display the Settings tool
palette  select the size when opening RAW images
in DPP.
Settings tool palette

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images
Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images
Remote
Shooting

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies

 The image size when opening RAW images in DPP is set.
 The default setting shows the size set in [Default size when
opening RAW images] in the [Image Processing 2] tab sheet in
[Preferences].
 The settings are saved as recipes for each image.
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Displaying and Saving RAW Images
Specify settings for displaying and saving RAW images.
This function allows you to select a [Prioritize speed] mode in addition to
the usual [Prioritize image quality (recommended)] mode.
Only RAW images shot with a supported camera are supported.

Supported Cameras
EOS-1D X Mark III, EOS R5, EOS R6

1 Select a supported image in the main window, etc.
2 Display the Settings tool palette.
3 Select the option.
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 After selecting an option, the RAW image is displayed based on
the setting.
The image quality of a converted and saved image is based on
the setting of the selected option.
 [Prioritize image quality (recommended)]: an image is displayed
and saved in normal DPP quality.
 [Prioritize speed]: sets a shorter time for displaying and saving
RAW images than [Prioritize image quality (recommended)].
However, some images may be displayed/saved with a
noticeable level of noise.
 [Prioritize speed] does not allow “Specifying the Size when
Opening RAW Images” (p.93) to be used.
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JPEG/TIFF

Saving Editing Results
Saving Editing Contents to an Image
All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu  desired item.
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Saving as a separate image
To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.
If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

1 Select the image to be converted.
2 Select the [File] menu  [Convert and save].
the necessary settings, and then click the
3 Specify
[Save] button.
 The [Convert and save] window appears.

 By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.
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Select the save
destination
 Your adjustments are saved to the image.

Click and save
Enter a file name
and select an
image type
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 The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.
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To save the developing/editing results for the version you are
currently using
DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.
Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.
When you want to save the developing or editing results of the version
you are currently using as it is, saving the image as a separate file (p.95)
is recommended.
 By saving as a separate JPEG or TIFF image as explained
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.
 By saving as explained above, a trimmed image (p.71) or dusterased image (p.86 to p.90) actually becomes a trimmed image
or dust-erased image.
 You can batch convert and save multiple images (p.139).
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JPEG/TIFF

Re-Editing an Image
Only the image processing conditions are changed in images adjusted
with the tool palette (p.45 to p.91), so the “original image data itself”
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.71) or dust-erased image (p.86 to p.90) is simply
saved to the image.)
For this reason, you can undo any adjustments saved (p.95) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

1
2 Select the [Adjustment] menu  desired item.

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images
Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images
Remote
Shooting

 The image reverts to the conditions of the selected item.
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JPEG/TIFF

Utilizing Adjustment Contents (Recipe)
All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.
You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images
Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

RAW image data
Image processing conditions information

JPEG, TIFF image data
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Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).
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 A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.
 Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.
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Copying a Recipe and Applying to Another Image
You can copy a recipe of an edited image and then apply it to another
image.

Select the image with the recipe you want to copy.

1
copy all items of a recipe, select the [Edit] menu 
2 To[Copy
recipe]. To copy only selected items of a
recipe, select the [Edit] menu  [Copy selected
recipe].

 The recipe is copied.
 To select recipe items, select the [Edit] menu  [Select and copy
recipe settings] and select items in the window that appears.
After specifying settings, click the [OK] button and close the
window.

3

Select the image to which the recipe is to be applied
and then select the [Edit] menu  [Paste recipe].
 The recipe is applied to the image.

Saving a Recipe as a File
an edited image, and then select the [Edit]
1 Select
menu  [Save recipe in file].

 The [Save recipe in file] dialog box appears.
 To save all of a recipe, select the [Save all recipes] option in the
window displayed.
 To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the
[Specify Recipe Details] button. In the window displayed,
checkmark the recipe settings to be saved and then click the
[OK] button.

the destination folder, enter a file name, and
2 Select
then click the [Save] button.
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You cannot copy or apply RAW movie recipes.
When a recipe for an image is copied and applied to an image in a
different orientation, the image orientation also changes. To prevent
the orientation of the image from changing, select the [Edit] menu 
[Select and copy recipe settings] and remove the check mark from
the [Rotate left / Rotate right: 0°] checkbox in the window that
appears.
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Loading and Applying Recipes
the image to which a recipe is to be applied,
1 Select
and then select the [Edit] menu  [Read and paste
recipe from file].

 The [Open] dialog box appears.

2 Select a recipe and click the [Open] button.
 The recipe is applied to the image.
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JPEG/TIFF

Adjusting by Comparing Multiple Images
You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

preview window, display the multiple images
1 Into the
be compared.
2 Align the images.

5

Move the area to be displayed.
 If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
 To cancel synchronization, select the [Preview] menu  [Sync
preview position] and [Sync preview display size] again.
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 Select the [Window] menu  [Arrange horizontally] or [Arrange
vertically].
 The preview windows are aligned.

Printing
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Select the [Preview] menu  [Sync preview position]
and [Sync preview display size].

3
4 Enlarge the image.
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 Enlarge and display any of the preview windows.
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 Other preview windows will also be displayed in the same
position/enlargement ratio.
Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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JPEG/TIFF

Editing Efficiently
Editing in the Edit Image Window
The thumbnail display and the preview window are combined, and
images can be edited efficiently while quickly switching between images
to be edited. Select the images to be edited beforehand in the main
window.
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Edit the image.
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1 Inedit.the main window, select the images you want to
2 Switch to the edit image window.
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Click
 The main window switches to the edit image window.
Edit image window

Change the display magnification
Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window
 For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.184).
 The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.
 To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.
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4 Click the area you want to enlarge.

Changing the Thumbnail Display Position to Horizontal
Select the [View] menu  [Horizontal Thumbnails].
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 The area you clicked is enlarged to 100% (actual pixel size).
 To change the display area, drag on the image or drag the
enlargement display area (p.19) of the navigator palette.
 Click again to revert to the full view ([Fit to window]).
 To return to the main window, click the [
] button on the
toolbar.

 If you select [Vertical Thumbnails], the thumbnail display reverts
to the vertical position.
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With the edit image window, you can only select images from a
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.104).
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Gathering and Editing Images in the Collection Window
You can gather selected images together in Collection folders for
viewing, comparison and editing.
You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

[+ Add collection] in the [Collection] area in the
1 Click
main window.

3

Select images or image folders in the main window.
Select the [File] menu  [Add to collection].
 The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.23) is added, the
number of images is indicated as two images.
 You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from
the menu that appears when you right-click the mouse.

4 Select a collection folder in the [Collection] area.
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 A new collection folder is created in the [Collection] area.
 Enter a name for the collection folder.
 To create additional collection folders, repeat the operation. Up to
20 folders can be created.

the [File] Menu  [Select collection], and
2 Select
select a collection folder to gather images from the
collection folder names displayed.
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 Images in the selected folder are displayed.
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5

Check the displayed images.

6 Edit the images.

 Edit the displayed images.
 Displayed images are retained in the collection folders even after
exiting DPP.

To remove images from collection folders
 Removing selected images
Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, right-clicking
with the mouse, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.
 Removing all images
Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.
 Deleting a collection folder
Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears when you right-click with the
mouse. Note that if you delete a collection folder, the original images
remain unaffected.
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Modifications to the image are applied to the original image
Modifications made to images in a collection folder are all applied to
the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.
Since the composited image is saved as a separate image, the original
images remain as they are.
 This function can be used with all image types (p.4) supported by
DPP.
 The color space of a composited image will be the color space of
the background image.
 Image information is not appended to a composited image.

1

Select a background image in the main window.
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2

Select the [Tools] menu  [Start Compositing tool].
 The compositing tool window appears.
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 You can also select a background image from the edit image
window or [Collection] window.
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3

Select the image to combine.
 Select the image to combine from the [Foreground Image] list
box.

4

Select a compositing method.
 Select a compositing method from the [Composite Method] list
box.
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 The selected image is displayed in the [Foreground Image]
thumbnail display.
 A preview of the combined background image and [Foreground
Image] is displayed in the composite preview.
 The following images can be combined.
• When a background image is selected in the main window:
images in same folder as background image
• When a background image is selected in the [Collection]
window: images in the [Collection] window
• When a background image is selected in the edit image
window: images displayed in the thumbnail display area
 You can also combine images of different sizes.
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 The compositing method selected in the composite preview is
applied.
 The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.109).
 If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.
 By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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5 Position the images.
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Shift large amount (50 pixels)
Shift small amount (1 pixel)
Align image centers
You can also directly enter the position
coordinates of the [Foreground Image]
to align it.
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 By default, the background image and the [Foreground Image] are
displayed with their centers aligned.
 [Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary.
 You can set [Compose in RAW Format] under the following
conditions.
Both the background image and [Foreground Image] are RAW
images, and all the following conditions are met.
• The cameras used to shoot were of the same model
• The ISO speed setting at the time of shooting was the same
• The highlight tone priority setting at the time of shooting was
the same
• The image sizes (original size) are the same
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 The following functions are not available for images composited
with [Compose in RAW Format].
• Auto Lighting Optimizer (p.58)
• Picture Style Auto (automatically set to Standard) (p.49)
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6 Click the [Save As] button.

 Specify the required settings in the window that appears and then
click the [Save] button.
 By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.
 To finish, click the [Close] button.

Compositing Methods
 Add
The background image and [Foreground Image] are added and
images are combined.
 Average
The background image and the [Foreground Image] are combined in
proportions of 50% each.
If you want to change the proportion of the [Foreground Image], select
[Weighted].
 Weighted
Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].
 Lighten
The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
 Darken
The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.
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You can display this function as a function button in the main
window’s toolbar (p.127).
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Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.
Since an HDR image is saved as a separate image, the original images
remain as they are.
* HDR stands for High Dynamic Range.

2

Select the [Tools] menu  [Start HDR tool].

3

Specify the required settings, then click the [Start
HDR] button.

 The [Select Images] window appears.
 You can also display the [Select Images] window from the edit
window and edit image window.
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 This function can be used with all image types (p.4) supported by
DPP except HEIF images.
 Image information is not appended to an HDR image.
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1 Select an image in the main window.
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 To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.
 If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.
 By clicking the [Start HDR] button, the [Adjust Image] window
appears.
After using auto image alignment, the periphery of the images is
partially deleted.
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4

Make required selections to adjust the image.

 Sliders in [Adjust Image] window
[Tone/Color]
[Brightness]: Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.
[Saturation]: Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.
[Contrast]: Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]
[Strength]:
Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.
[Smoothness]:Adjusts the overall smoothness of the image.
Move the slider to the right for a smooth and
natural impression.
[Fineness]:
Adjusts the clearness of details. Move the slider
to the right for a sharper outline.
 [Presets] and finishing effects
With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.
[Natural]:
In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.
[Art standard]: Gives a finish with painting-like tonality for an
impressive image.
[Art vivid]:
For a more vivid look than with [Art standard].
[Art bold]:
For a more vivid look than with [Art standard],
that makes the subject pop out.
[Art embossed]: Tones down vividness more than [Art standard],
for an old-fashioned feel.
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5 Click the [Save As] button.
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 Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.
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You can display this function as a function button in the main
window’s toolbar (p.127).
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Using the Dual Pixel RAW Optimizer
By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.
Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
 Common to all functions
• Effects are most easily gained when the lens aperture value is
f/5.6 or lower.
• Effects may be different between shooting in vertical orientation
and horizontal orientation.
• It is recommended that the ISO speed be ISO 1600 or lower.
 Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
• It is recommended that the lens focal length be at least 50 mm.
• It is recommended that this function be used when the camera
is at a distance from the subject.*
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m - 10 m / 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx. 2 m - 20 m / 6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx. 4 m - 40 m / 13.1 ft. - 131.2 ft.
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Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File
Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

1

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.
 The Dual Pixel RAW Optimizer window appears.
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2 Checkmark the [Image Microadjustment] checkbox.
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You can display this function as a function button in the main
window’s toolbar (p.127).
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3

Adjust the image.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result
Reposition the viewpoint or foreground bokeh for a more pleasing result,
using the dual pixel information recorded in Dual Pixel RAW images.

main window or edit image window, select the
1 InDualthePixel
RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.
 The Dual Pixel RAW Optimizer window appears.
 Use the slider to adjust the resolution based on depth information
and the level of resolution.

4

Click the [OK] button.

2 Checkmark the [Bokeh Shift] checkbox.
3 Specify the area to adjust.

 Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).
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 If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.
 This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“Reduces the appearance of ghosting in images”.

 Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.
You can also remove the check mark from the [Show borders]
checkbox to hide the border.
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4

Adjust the image.

Reduces the Appearance of Ghosting in Images
Reduce the appearance of ghosting in images, using the dual pixel
information in Dual Pixel RAW images.

main window or edit image window, select the
1 InDualthePixel
RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.
 The Dual Pixel RAW Optimizer window appears.

the [Ghosting Reduction] checkbox, and
2 Checkmark
specify the area.
 Use the slider to adjust the viewpoint.

5 Click the [OK] button.
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 Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).
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 If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.
 Resolution may expand in the depth direction according to the
level of adjustment.
 If the border of the selected area in the image appears unnatural,
lower the level of adjustment.
 This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

HDR PQ
Mode

 Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.
You can also remove the check mark from the [Show borders]
checkbox to hide the border.
 Any ghosting and flare in the specified area is reduced.

Specifying
Preferences

115

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

3

Click the [OK] button.
 Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).
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 There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.
 There may be cases where the border of the selected area in the
image looks unnatural.
 This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reposition the viewpoint or foreground bokeh
for a more pleasing result”.
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Using Depth Compositing
Depth compositing generates a single image from several images that is
in focus over a wide area. This function combines images with the Depth
Compositing tool, and outputs the combined result as a depth composite
image. It is then possible to also correct the output image using the
Depth Compositing Editing tool.
This function can also be used with images shot without using focus
bracketing on the camera.
See “Cautions when shooting images for depth compositing” (p.118)
and “Cautions for using depth compositing” (p.119).

Using the Depth Compositing Tool

1 Select multiple images in the main window, etc.

 For images shot using focus bracketing on the camera, you can
perform depth compositing even if you select only one image.

the [Tools] menu  [Depth Compositing] 
2 Select
[Start depth compositing tool].
 The Depth Compositing tool window appears.

Supported Images
images*1:

Cameras

• JPEG, TIFF
All cameras compatible with DPP
• RAW images:
EOS 5D Mark IV, EOS R5, EOS R6, EOS R, EOS
Ra, EOS RP, EOS 90D, EOS M6 Mark II,
PowerShot G5 X Mark II, PowerShot G7 X Mark III

Lenses

RF, EF, and EF-S lens groups (excluding TS-E lenses
and fisheye lenses)

Supported
formats

CR2, CR3, JPG, TIFF*1

Shooting
conditions

The camera, lens, shutter speed, aperture value,
focal length, image format, and image size must be
the same.

*1

TIFF images converted and saved in DPP

 Even if the above conditions are met, the following images are not
supported by depth compositing.
• RAW images created by multiple-exposure shooting
• Images without shooting information
• Images saved as HDR PQ mode display images
• Images of 1600 x 1600 pixels or less, or 9999 x 6666 pixels or more
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3

Adjust and set items as necessary, and then click the
[Execute] button.

 Images are combined and a depth composite image is output.
 A source image folder (folder name: DPP_DC_...) is output in the
same folder as the depth composite image.
The source image folder is used to correct the depth composite
image with the [Depth Compositing Editing Tool].
 To change the output destination or format of a depth composite
image, click the [Browse] button to make the settings in the
window that appears.
 [Auto brightness adjustment] suppresses any change in
brightness between images used for depth compositing with
automatic correction when brightnesses are slightly different.
You can display this function as a function button in the main
window’s toolbar (p.127).

Cautions when shooting images for depth
compositing
 After performing depth compositing, the combined result may
have a narrower angle of view than when images were shot.
When shooting with focus bracketing, shooting with a wider angle
of view is recommended. After depth compositing, you can crop
the image if necessary.
 For best results, set the aperture value in a range of f/5.6–11
before shooting.
 Be sure to use a tripod and lock the camera firmly in place before
shooting.
 Repeating patterns such as lattice patterns and stripe patterns, or
images where the entire screen is flat and lacking contrast may
not be combinable.
 When shooting multiple images, start by focusing on the image
nearest to you and work progressively farther away.
 When shooting multiple images, images where the focus differs
largely may result in a combined image with uneven focus or that
may not be combinable.
 Depth compositing assumes that images of still subjects are
being combined. Images shot of moving subjects may not be
combinable.
 If multiple subjects are in the screen, images may not be
combinable depending on how subjects are arranged, for
example, subjects spaced far apart.
 The lenses below are recommended.
RF35mm F1.8 MACRO IS STM, RF50mm F1.2 L USM, RF2870mm F2 L USM, RF24-105mm F4 L IS USM
EF16-35mm f/4L IS USM, EF24-70mm f/4L IS USM, EF100mm
f/2.8L MACRO IS USM, EF180mm f/3.5L MACRO USM
EF-S35mm f/2.8 MACRO IS STM, EF-S60mm f/2.8 MACRO
USM, EF-S18-135mm f/3.5-5.6 IS USM
EF-M28mm f/3.5 MACRO IS STM, EF-M15-45mm f/3.5-6.3 IS
STM, EF-M18-150mm f/3.5-6.3 IS STM
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Cautions for using depth compositing
 When the Depth Compositing tool is started up, the content of
recipes that are attached to images in focus is reflected in the
depth composite image (excluding the following items).
• Stamp
• Dust delete data
• Reducing color moiré (Partial Adjustment tool palette)
• Angle adjustment (Trimming/Angle Adjustment tool palette)
• Size setting when opening selected RAW image in DPP (p.93)
• Color adjustment for a specific color gamut (including
[Monochrome])
• Dual Pixel RAW Optimizer
• Auto Lighting Optimizer
• Shadows/highlights
 The Depth Compositing tool does not start up if an image in focus
is not supported.

Using the Depth Compositing Editing Tool
If intended results were not obtained with the Depth Compositing tool,
this function copies the portion of the image to be corrected from a
source image to the depth composite image (in this tool, the [Edited
Image]).

the depth composite image in the main
1 Select
window, etc.
the [Tools] menu  [Depth Compositing] 
2 Select
[Start depth compositing editing tool].
 The Depth Compositing Editing tool window appears.
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 A thumbnail of the source image is automatically displayed at the
bottom of the screen. However, thumbnails of source images are
not automatically displayed if the name of the depth composite
image or the source image folder is changed or the save location
is moved. Select the source image folder that was output at the
same time the depth composite image was output.
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3 Select a source image and modify it as necessary.
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 Select a source image from the thumbnails of source images
displayed at the bottom of the screen.
 If the [Source Image] and [Edited Image] are shots of different
areas, a black frame may be displayed around the [Source Image].
 Clicking the [Set Adjustment Area] button displays a circular cursor.
Click or drag the portion of the [Edited Image] that you want to
correct with the circular cursor, and the same portion of the [Source
Image] is copied.
 Use [Radius] to set the size of the adjustment area, and use [Blur
radius] to set blurring at the border of the adjustment area.

 You can return through the corrections you made with the
[
][
][
][
] buttons. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All]. However, if you
changed to another source image, you cannot return through
corrections you made using the source image before the change.
 A recipe attached to a depth composite image is not applied in the
[Edited Image] in this function.
Also, depth composite image recipes are not attached to image
files saved with this function.
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4 Save the image.
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 Click the [Save As] button to select and save required settings.
 To exit, click the [Close] button.
You can display this function as a function button in the main
window’s toolbar (p.127).
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Advanced

Using the RAW Burst Image Tool
This function can be used with rolls (continuous-shot image files)
captured in RAW burst mode on Canon digital cameras.
A roll is edited, saved, printed, etc. as a single RAW image in DPP,
however, a “representative image”* is selected automatically for this
purpose.
For detailed information on RAW burst mode, refer to the Instruction
Manual included with a RAW burst mode-capable camera.
You can use this tool to do the following:
• Change the representative image in a roll
• Save one image in a roll
• Extract and save any range in a roll
* Representative image: the image displayed in thumbnails, etc.
representing all the images in a roll
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2

Select the [Tools] menu  [Start RAW Burst Image
tool].
 The RAW Burst Image Tool window is displayed.
 To exit, click the [Close] button.

Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images

Starting Up the RAW Burst Image Tool

1 Select a roll in the main window, etc.

Remote
Shooting

 Only rolls shot with RAW burst mode on a Canon digital camera
are supported.
(Thumbnail icon:
)
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You can display this function as a function button in the main
window's toolbar (p.127).

122

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

RAW Burst Image Tool window functions

Viewing
Images
Sorting
Images

Image display area

Set image display
magnification
Display image at no
magnification
Display image fit to window
Lead image marker (p.125)
Slider (p.124, p.125)

Representative image mark
Displayed when
representative image
displayed
Set displayed image as
representative image (p.124)
Move to representative
image
Revert to image when
captured
Discard all editing done with
this tool and revert to image
when captured

Set lead image in roll after
extracting (p.125)

Extract and save any range
in a roll (p.125)

Move to image before
(p.124, p.125)

Save one image in a roll
(p.124)

Number of displayed image
Number of displayed image/
number of all images in roll are
displayed

Set last image in a roll after
extracting (p.125)

Position of representative
image in roll

Move to image behind
(p.124, p.125)
Last image marker (p.125)
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Changing the Representative Image in a Roll

Saving One Image in a Roll

You can change the representative image to any image in a roll.

You can extract any one image in a roll and save it.

1 Display the RAW Burst Image Tool window.

1 Display the RAW Burst Image Tool window.

 Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
 The RAW Burst Image Tool window is displayed.

the image you want to be the representative
2 Display
image.

 Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
 The RAW Burst Image Tool window is displayed.

2 Display the image you want to save.
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 Use the slider or [
] and [
] buttons to display the
image you want to set as the representative image in the image
display area.
 The position of the current representative image is indicated with
a[
] mark above the slider.

 Use the slider or [
] and [
] buttons to display the
image you want to save in the image display area.

3

Save the image.
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3 Change the representative image.

 Click the [Use as Rep. Image] button.
 The representative image changes to the currently displayed image.
 To revert to the image when captured, click the [
] button.
 To exit, click the [Close] button.

Remote
Shooting

HDR PQ
Mode

 Specify the necessary settings in the window that appears by
clicking the [
] button and save the image.
 To revert settings to those when captured, click the [
]
button.
 To exit, click the [Close] button.
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Extracting and Saving Any Range in a Roll
You can extract any range in a roll and save it as a separate roll.

3

Set the last image.

Viewing
Images

1 Display the RAW Burst Image Tool window.

Sorting
Images

 Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
 The RAW Burst Image Tool window is displayed.

2

 Use the slider or [
] and [
] buttons to display the
image you want to set as the last image in the image display
area, and then click the [
] button.
 The last image marker (
) moves, and the last image in the roll
is set.

Set the lead image.

4
 Use the slider or [
] and [
] buttons to display the
image you want to set as the lead image in the image display
area, and then click the [
] button.
 The lead image marker (
) moves, and the lead image in the
roll is set.

Save the roll.
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 Specify the necessary settings in the window that appears by
clicking the [
] button and save the roll.
 To revert settings to those when captured, click the [
]
button.
 To exit, click the [Close] button.
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Advanced

Transferring a RAW Image to Photoshop
A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu  [Transfer to Photoshop].
 Photoshop starts up and the transferred image is displayed.
A single image can be transferred at a time
Only one image can be transferred at a time. To send multiple images at
a time, see p.141.
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 Editing performed with this function is not supported with these
functions: “Copying a Recipe and Applying to Another Image”
(p.99), “Saving a Recipe as a File” (p.99), and “Loading and
Applying Recipes” (p.100).
 Editing performed with this function cannot be reverted to the
states in [Revert to shot settings] or [Revert to last saved settings]
in the [Adjustment] tab in the menu even if they are selected.
However, you can press this function's [
] button to revert
the image to the captured image.
 Even after changing the representative image in a roll with this
function, shooting information for the roll displayed in the main
window, etc. is information for the representative image at the
time of shooting.
 Adjustments (recipe) made to a roll in the main window, etc. are
not applied in the window for this function (except for 90° image
rotation).
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 Compatible versions of Photoshop are 7.0 or later.
 Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.185) is added. The ICC profile
contains information about [Preferences] (p.177) or work color
space (p.91) set for each image as described and the appropriate
color information is relayed to Photoshop.
 When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.
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Advanced

Customizing the Main Window Toolbar
You can display buttons for frequently-used functions in the main
window’s toolbar.
You can also change how the buttons are laid out.

1 Select the [Tools] menu  [Customize toolbar].
2 Select functions to display in the toolbar.
 The [Configure Toolbar] window appears.
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 To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.
 After specifying settings, click the [Close] button and close the
window.
 The settings are applied to the main window’s toolbar.
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Advanced

Using Cloud Processing
It has become possible starting with DPP version 4.12.10 to use the
network service “Canon Cloud Imaging” to process supported images
with higher-performance noise reduction.
This processing is called “Cloud Processing”.
This section explains how to use this function. This function cannot be
used if you select China as your region when installing DPP.

Supported Images
ISO 3200 or higher RAW images shot using an EOS-1DX Mark III

Enabling Cloud Processing
To use cloud processing, you must first enable it.
How to enable cloud processing is described below.

the main window, etc., select [Enable cloud
1 Inprocessing]
in the [Cloud] menu.
the contents in the dialog box that appears,
2 Check
and click the [Agree] button to agree and start using
the function.

Requirements for Using this Function
OS: Windows 10 (1709) or later
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Start up [Setup.exe] in the [DCC] folder that appears
and install [DPP Cloud Connect].
 If [DPP Cloud Connect] installation fails, on your PC, navigate to
[Windows Settings][Update & Security][For developers] and
select [Sideload apps] from the [Use developer features] menu,
and install again.
After completing installation, return option selections in the [For
developers] menu to as they were.

4 Restart DPP.
main window, etc., select and run [Log in] in
5 Inthethe[Cloud]
menu.
 [Cloud Box] appears in [Collection] in the main window.

 Cloud processing is enabled.
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Cloud Processing and CIP Image Editing
By using cloud processing, a “CIP image” is generated from the original
RAW image. The “CIP image” is an image that has been processed with
higher-performance noise reduction by using the network service
“Canon Cloud Imaging”.
The procedure for cloud processing and editing CIP images is described
here.

1 Enable cloud processing (p.128).
the main window, drag the image you want to use
2 Incloud
processing to [Cloud Box] in [Collection].
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 To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required.
 Internet Service Provider (ISP) connection fees or access point
connection fees may apply.
Disabling cloud processing
You can disable cloud processing with the following procedure.
1 In the main window, etc., select [Disable cloud processing] in the
[Cloud] menu.
 Start up the uninstaller, and [DPP Cloud Connect] is
uninstalled.

2

Start up DPP again.
 Cloud processing is disabled.
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Cloud Box
Special folder for working with images generated after cloud
processing.
The number of remaining that can be processed currently is
displayed.
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 Cloud processing is carried out. As a result of cloud processing,
a CIP image is generated from the RAW image and saved in
[Cloud Box]. The original RAW image is not affected by cloud
processing.
 CIP images are displayed with a [
] icon in the thumbnail
image.
 You can also select an image you want to use cloud processing
and select the [Cloud] menu  [Process in cloud] to use cloud
processing.
 To stop the process during cloud processing, select [Cancel]
from the menu that appears by right-clicking with the mouse. An
image for which cloud processing was stopped is displayed with
a [!] icon in the image’s thumbnail image in [Cloud Box], but you
can continue cloud processing again.
 If cloud processing fails, an image is displayed with a [!] icon in
the thumbnail image in [Cloud Box]. Continue cloud processing
again.
 You cannot edit [Digital Lens Optimizer], [Diffraction correction],
or [Chromatic aberration] settings for CIP images. It is
recommeded that you complete this editing before using cloud
processing.
 You cannot carry out [Cropping], [Stamp], or [Partial adjustments]
during cloud processing.
 CIP images cannot be handled with software other than DPP.

[Cloud Box], select the CIP image you want to
3 Open
edit, and edit.
 CIP images can be edited in the same way as normal RAW
images.
However, you cannot edit [Digital Lens Optimizer], [Diffraction
correction], [Chromatic aberration], [Compose in RAW Format] in
the compositing tool, or [Size when opening RAW images]
settings.

Using Noise Reduction (Cloud)
[Noise reduction (cloud)] in the Detailed Adjustment tool palette is a
noise reduction function that can be used only with CIP images
generated after cloud processing. How to use this function is described
here.

[Cloud Box] in the main window (p.129), and
1 Open
select an image.
2 Open the Detailed Adjustment tool palette (p.69).
the [Noise reduction (cloud)] checkbox,
3 Checkmark
and make adjustments.
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Enter a setting (in 0.1stop increments)
Drag the slider left or right
 You can set a noise reduction level from within a range of -4.0 to
4.0.
The larger the setting, the larger the noise reduction effect.
 The noise reduction effect can also be checked in the check
window.
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Printing Images
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Printing an Image .................................................. 132
Printing with Shooting Information......................... 133
Printing a Thumbnail List (Contact Sheet
Printing) ................................................................. 134
Plug-in printing....................................................... 135
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Printing an Image
You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

1 Select the image to be printed.
2 Select the [File] menu  [Print].
3 Print.

 The printer’s print settings dialog box appears.
 Specify the optimum settings for printing photographs in the
printer’s print settings dialog box and click the [OK] button.
 Printing begins.
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Printing with Shooting Information
You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

1 Select one image to be printed.
2 Select the [File] menu  [Print with detailed setting].
the required settings for printing, and then
3 Specify
click the [Print] button.
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To maintain the settings
The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can be applied to another
image when printing.
Memorized settings are options in [Printer], [Media], [Media orientation],
[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.

Switches the settings tab sheet
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Print preview
 The image can be moved by dragging.
 Drag the four corners of the image to change the size.
 For the shooting information, click [
] on the [Text] tab sheet
and select the necessary items in the window that appears.

 You can set printer profiles (p.178).
 If CMYK simulation is set, the image is printed in the set colors.
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Printing a Thumbnail List (Contact Sheet Printing)
You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

1
2 Select the [File] menu  [Print contact sheets].
the required settings for printing, and then
3 Specify
click the [Print] button.

Switches the settings tab sheet

To maintain the settings
The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.
Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.
 You can set printer profiles (p.178).
 If CMYK simulation has been set, the image is printed in the set
colors (p.177).
 By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.
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Plug-in printing
Select the [File] menu  [Plug-in printing]  Plug-In
1 for
the printer you use.
 The Plug-In starts up.

the required settings for printing
2 Specify
photographs and then print.
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Processing Large Numbers of RAW Images
Batch Apply White Balance to Images (Personal White
Balance) ................................................................ 137
Registering Personal White Balance ........................ 137
Applying Personal White Balance ............................ 138
Batch Save as JPEG or TIFF Images (Batch
Processing)............................................................ 139
Batch Transfer Images to Image Editing Software ......... 141
Batch Change the File Name of Images................ 142
Changing the File Name of Images in the Order in the
Main Window ............................................................ 142
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Batch Apply White Balance to Images (Personal White Balance)
The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.
Personal white balance data for versions before DPP 4 cannot be
applied.
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Registering Personal White Balance

1 Adjust the white balance

(p.52, p.53).
 To adjust white balance, select a setting other than [ ( )] from
the [White balance adjustment] list box (p.51). Registering the
adjustments is not possible if [ ( )] is selected.
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the Basic adjustment tool palette, click the
2 In[Register]
button.

 The [Register personal white balance] dialog box appears.

Remote
Shooting

the button number to be registered from the
3 Select
list and click the [OK] button.
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To use the registered personal white balance on another
computer

1 In step 3, click the [Save] button to write as a file.
2 Copy the file to another computer.
3 In DPP on another computer, display the window of step 3.
4 Click the [Load] button and in the window that appears, select the

HDR PQ
Mode
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copied file.

You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Applying Personal White Balance
the main window, select the image to which a
1 Inpersonal
white balance is to be applied.
2 Select the [View] menu  [Tool palette].
the personal white balance number button that
3 Click
is to be applied.
 The tool palette appears.
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 Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)
You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain
unaffected.

4

In the processing dialog box, click the [Exit] button.
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In the main window, select multiple images to be
converted.

1
2 Select the [File] menu  [Batch process].
the required settings, and then click the
3 Specify
[Execute] button.
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 The [Batch settings] window appears.
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 The batch processing dialog box appears and saving begins.
 When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

 If you have selected [New file name] in [File name], [Sequence
number] has to be set.
 By saving as explained above, a trimmed image (p.71) or dusterased image (p.86 to p.90) actually becomes a trimmed image
or dust-erased image.
 You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
converted and saved.
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Saving images with recipe is not possible
In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.95) to edited RAW images.
To save the developing/editing results for the version you are
currently using
DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.
Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.
When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.
Skillful batch saving
 While saving is being performed, you can continue working in
another window
Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.
 To convert all images and save, do not select an image in the
main window
If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software
Select Photoshop.

You can transfer multiple images to image editing software. Unlike
“Transferring a RAW Image to Photoshop” (p.126), you transfer images
that have first been converted and saved as a separate image, so the
transferred image will not be deleted after exiting the destination
software. The software used here as an example is Adobe Photoshop.

5

the main window, select multiple images to be
1 Intransferred.
2 Select the [File] menu  [Batch process].
settings required for transferring (e.g. file
3 Perform
format).
4 Checkmark [Open image using software].

6 Click the [Execute] button.

 The [Batch settings] window appears.

 In the [Open] dialog box, select a Photoshop file or a shortcut
and click the [Open] button.
 The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop.
 The processing dialog box appears and batch transfer begins.
 When the first image has been transferred, Photoshop starts up
and transferred images are displayed in transferred order.
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 The [Open] dialog box appears.

 To reset the transfer destination to another software, click the
[Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
button.
 You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
transferred.
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Batch Change the File Name of Images
window, select multiple images of which
1 Inthethefilemain
names are to be changed.
2 Select the [Tools] menu  [Start Rename tool].
the required settings and click the [Execute]
3 Specify
button.
 The rename window appears.

Changing the File Name of Images in the
Order in the Main Window
When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

the order of the images in the main window
1 Change
.
window, select multiple images of which
2 Inthethefilemain
names are to be changed.
3 Select the [Tools] menu  [Start Rename tool].
4 Select [Fit to main window].
(p.36)
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 Processing begins and the file names are changed.
Changes cannot be made when the file name is duplicated
If a file name in red text appears in [Modified File Name], the file name is
duplicated. Changes cannot be made if even one file name is
duplicated. Change the settings so that duplication does not occur.

Specify the required settings.

5
6 Click the [Execute] button.

 To copy an image, checkmark [Copy and Rename].
 The file names are changed and the order in the main window is
maintained.
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 You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.
 You cannot start up the rename tool from the [Collection] window
(p.104). You also cannot change the file name of one image.
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Remote Shooting
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Remote Shooting
You can perform remote shooting by using “EOS Utility” which enables
communication with a camera in combination.
For remote shooting, “EOS Utility Ver. 3.x” must be installed on your
computer. For information on cameras compatible with “EOS Utility Ver.
3.x”, refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual
in PDF format).

the [Remote Shooting] button on the toolbar in
1 Click
the main window.

 To save to the currently selected folder, select [Current Folder].
 To create a new folder for saving images, select [Use this folder],
click the [Select] button, then select the destination and enter a
name for [Destination folder].
 After specifying settings, click the [OK] button.
 The remote shooting window appears.
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 Remote shooting setting window appears.

the [Destination] in the Specify Remote Shooting
2 Set
Folder window.
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You can change the [File Name] for Specify Remote Shooting
Folder window.
(If [Do not modify] is selected, images are saved with the file names
set on the camera.)
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1 Click the [Settings] button to display the Set file name for captured
image window.
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 You can perform shooting while checking the image by switching
the window to multi-layout.

Connect a camera and a computer, and turn on the
camera’s power.

2 Select a naming rule for image file names from the list box.

You can click the [Customize] button and customize naming rules
for file names.
 You can individually set prefix characters, number of digits for
serial numbers, and the start number for file names.
 If you are using the shooting date in file names, you can specify
the date format (order and style for year-month-date) and
dividing characters on the Set file name for captured image
window.

3
4 Click the [Live View] button.
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3 After specifying settings, click the [OK] button.

The Set file name for captured image window closes.
 After clicking the [Remote Shooting] button, you can click the
[
] button at the bottom right of the main window to show/
hide the [Camera Control] palette.
 Live View window of “EOS Utility” appears.

145

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

5

Specify the required settings.

7

Specify the required settings.
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 For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

6 Click the [Settings] button.

Playing Back
Movies and Saving
Still Photos

 For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

8 Take the picture.
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 The capture window of “EOS Utility” appears.
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Registering Click White Balance in the Camera
During remote shooting, you can register click white balance to the
connected camera. To use this function, EOS Utility version 3.4.20 or
later must be installed on your computer.
This function is not available on EOS M series cameras other than the
EOS M50 Mark II, EOS M50, or PowerShot cameras.

1

Display the shot image to be used as the standard
for white balance.
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 The shot image is displayed.
 The shot image will be saved in the folder created in step 2.
 The images in the folder mentioned above will be displayed in
the thumbnail display area.
You can also create a sub-folder in the folder mentioned above to
save images. To create a sub-folder, click the [Create subfolder]
button on the remote shooting window, enter [Folder name] on
the screen appeared, then click the [OK] button.
 Press the [
] button to display DPP and EOS Utility windows
uniformly in line.
• Supported with EOS Utility version 3.8 and later.
• If you are using multiple monitors, DPP’s main window and
EOS Utility’s remote window can only be lined up uniformly
when on the same monitor.
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 This function supports only RAW images with a “.CR2” or “.CR3”
extension.

the destination where to register click white
2 Select
balance.

Handling
RAW Movies
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Do not exit “EOS Utility” when remote shooting is being set or
performed.
 In the cases below, perform shooting with EOS Utility.
• You want to autofocus with EOS Utility’s shoot button
• You want to perform continuous shooting
 You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.21). This is convenient for
image selection.
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 Select the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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3

Select a point that is to be the standard for white
balance in the shot image, and register the white
balance in the camera.
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 Click the [
] button, and in the displayed image in step 1,
click on a point that is to be the standard for white balance with
the mouse.
 The white balance is registered to the destination selected in
step 2, and applied to displayed images.
 Click [
] again to exit the function.
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Playing Back Movies and Saving Still Photos
In systems running Windows 8.1 or later, you can use DPP to play back MOV or MP4 movies shot using a supported camera and save still photos from
the movies as JPEG or TIFF images. To use this function, [Play with Digital Photo Professional 4] must be selected in [Movie file playback] in the
[General Settings] tab sheet in [Preferences].
Note that you cannot edit MOV or MP4 movies in DPP. For details on playing back RAW movies and saving still photos, see “Working with RAW
Movies” (p.154).

1 Double-click the movie thumbnail in the main window (thumbnail layout).
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 The preview window appears.
 If the preview control panel does not appear, select the [Preview] menu  [Preview control panel].
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2

Use the preview control panel for each operation.
(10) Save as still photo

Viewing
Images

(4) Show playback time
(5) Frame position slider
(6) Frame no./Total frames
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(2) Next frame
(1) Play/pause

(7) Mute/unmute
(8) Volume slider

(3) Previous frame

(9) Viewing LUT on/off

(1) Play/pause
Play and pause the selected movie.

(7) Mute/unmute
Turns audio output on or off.

(2) Next frame
Move forward one frame. When movie playback is paused,
this allows you to advance the movie one frame at a time.

(8) Volume slider
Drag the slider left or right to adjust the volume for the
movie being played back.

(3) Previous frame
Move back one frame. When movie playback is paused,
this allows you to rewind the movie one frame at a time.

(9) Viewing LUT on/off
Enables or disables Viewing LUT for movies shot with
Canon Log specified.
This setting can also be changed during movie playback.

(4) Show playback time
Shows the playback time.
(5) Frame position slider
By dragging the slider left or right, you can move the
playback position while a movie is playing or paused.
(6) Frame no./Total frames
Shows the current frame number in the movie being
played back or shown and the total number of frames.

(10) Save as still photo
Allows you to capture a still photo of the movie frame
currently being displayed.
When you click the button, the [Convert and save] window
(p.95) appears. Specify the necessary settings, and then
click the [Save] button to save the image.
Note that you cannot save a still photo while the movie is
playing back. Pause the movie and then save the still
photo.
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 If the preview control panel does not appear, select the [Preview] menu  [Preview control panel].
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 MP4 movies shot with Canon Log are converted to sRGB color
space before being displayed and saved.
 You can play back MP4 movies that have [HDR PQ] set to [On]
with HDR PQ. To display movies in HDR PQ, your computer
system must meet the “System Requirements for HDR PQ Mode”.
On a system where display in HDR PQ is not possible, a movie is
displayed in SDR based on the [HDR assist display (movies)]
(p.179) setting in [Preferences].
Only HEIF format can be selected for saving still photos (p.172).
 On some supported cameras, shooting a movie generates a
“.THM” file that is saved together with the movie file.The “.THM”
file has the same image number as the movie file and records the
shooting information. In DPP, the movie file and “.THM” file must
be stored in the same folder when the movie is played back.
 You can also play back movies in the following windows:
• Main window (multi-layout)
• Edit image window
• Remote shooting window (multi-layout)
• Multi-function preview window
 In Preferences, you can change the movie playback application
to that used by your computer’s OS or to EOS MOVIE Utility.
(p.174)
For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.
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Working with RAW Movies .................................... 154
Supported Cameras ................................................. 154
Changing the Image Displayed for a RAW Movie .... 154
Grabbing and Saving a Displayed RAW Movie
Image........................................................................ 155
Saving Several Still Photos from a RAW Movie ....... 156
Starting Up the RAW Movie Tool.............................. 157
Playing Back RAW Movies ....................................... 160
Saving any Range of a RAW Movie as Still Photos . 161
Grabbing and Saving any Range from a RAW
Movie ........................................................................ 162
Editing a RAW Movie................................................ 162
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Working with RAW Movies
Users can work with the RAW movie (extension: .CRM) format in DPP
version 4.12.0. RAW movies can be handled as either movies or still
photos in DPP.
As a movie, they can be played back and edited using the RAW movie
tool.
As a still photo, they can be handled as a RAW image file in the same
way as CR2/CR3. However, RAW movies shot with a camera having
Canon Log set ON are developed with Canon Log OFF.
DPP supports RAW movies shot only with a supported camera. RAW
movies shot with a camera having Canon Log 3 set ON are not
supported.
This section explains how to work with RAW movies.

Supported Cameras
EOS-1D X Mark III, EOS R5

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

Changing the Image Displayed for a RAW Movie
You can change the image displayed for a RAW movie file to any frame
within the file.
While you can edit, save, print, etc. a RAW movie file as a single RAW
image in DPP, the displayed image is automatically selected for doing
this.

1 Select a RAW movie file in the main window, etc.
 The thumbnail icon is [

].

Display the Settings tool palette.

2
the frame you want to set as the display image
3 Select
in [RAW movie frame selection].
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 Use the slider or [
] and [
] buttons to select the frame you
want to set as the display image, and the display image changes.
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Grabbing and Saving a Displayed RAW Movie Image
You can grab and save the frame of the displayed RAW movie file
image.

1

3

Set items as necessary and click the [Save] button.
[Grab current frame from RAW movie and save] dialog
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Select a RAW movie file in the main window, etc.
 The thumbnail icon is [
].
 To change the displayed image, follow the steps in “Changing the
Image Displayed for a RAW Movie” (p.154).
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Select the [File] menu  [Grab current frame from
2 RAW
movie and save], and click [OK] in the dialog

Printing
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that appears.

 The [Grab current frame from RAW movie and save] dialog
appears.
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 The frame is saved based on specified settings.
 Savable format is only CRM.
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Any image editing made to the original movie file is not carried over
to the new saved file.
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Saving Several Still Photos from a RAW Movie

[Save Settings] dialog box

Viewing
Images

You can save several still photos from a RAW movie file.

1 Select a RAW movie file in the main window, etc.
 The thumbnail icon is [

2

Sorting
Images

].

Select the [File] menu  [Save still image from RAW
movie].
 The [Save Still Image from RAW Movie] dialog box appears.

3 Set items as necessary

[Save Still Image from RAW Movie] dialog box

Editing
Images

• [Save the specified number of frames]: Specify the number of
frames and save.
[No. of frames before] specifies the number of frames before
the display image (selected frame) to save.
[No. of frames after] specifies the number of frames after the
display image (selected frame) to save.
Up to 10 frames can be saved with each of [No. of frames
before] and [No. of frames after].
• [Save the range between in and out points]: All frames in the
range selected in the RAW movie tool are saved as still
photos.
• After specifying settings, click the [OK] button.
 The [Save Settings] dialog box closes.
 [Destination folder settings]: Specify the destination folder where
still photos are saved.
 [Output setting]: Specify settings for outputting still photos.
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 [Save range settings]: Set the range of frames to save. By
default, only the single display image frame (selected frame) is
set. Set the range in the [Save Settings] dialog box that appears
by clicking the [Settings] button.
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4

Save the still photos.

Starting Up the RAW Movie Tool
The RAW movie tool allows you to play back and edit RAW movie files.

 Click the [Execute] button to create a folder in the destination
folder with the name of the movie file. Still photos are saved
according to the settings specified in step 3.

 The environment below is recommended for running the RAW
movie tool.
The minimum environment also below is necessary for running
the RAW movie tool.
Recommended environment
• CPU: Intel Xeon CPU E5-2687W v3 3.1 GHz x 2 or more (max.
3.5 GHz using Turbo Boost)
• GPU: NVIDIA GeForce RTX 2080
• RAM: 32 GB or more
• Storage: SSD readable 400 MB/s or faster
Minimum environment
• CPU: Intel Core i series or later
• GPU: Environment with NVIDIA GPU
• VRAM: 4 GB or more (8K movies: 8 GB or more)
* The RAW movie tool cannot run in a non-NVIDIA GPU
environment (example: AMD GPU, Intel GPU).
 Install the latest-version GPU driver.
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Depending on your system requirements or the number of frames
being saved, it may take a long time to save.
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1 Select a RAW movie file in the main window, etc.
 The thumbnail icon is [

].

2 Select the [Tools] menu  [Start RAW Movie Tool].
 The RAW Movie tool window appears.
 To exit, click the [Close] button.
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List of RAW Movie Tool Window Functions

Viewing
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[Save movie] button (p.162)

Sorting
Images

[Grab and save] button
(p.162)

Editing
Images

Printing
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Frame display area
Tool palettes (for RAW
movies) (p.162)

Set last frame for saving
(p.161)
Next frame (p.160)
Play/pause (p.160)
Previous frame (p.160)
Set start frame for saving
(p.161)

Show playback time
In point marker (p.161)
Out point marker (p.161)
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Display frame fit to window (p.21)
Display frame at no magnification (p.21)
Set the frame display magnification (p.21)
Reduce/enlarge the frame (p.21)
Mute/unmute (p.160)
Volume slider (p.160)
Viewing LUT on/off (p.162)

Frame no./Total frames (p.160)
Frame position slider (p.160)
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Playing Back RAW Movies
You can play back RAW movie files with the RAW movie tool.

a RAW movie file in the main window, etc., and
1 Select
start up the RAW movie tool.
 Start up the RAW movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

2 Control movie playback.
Next frame
Play/pause
Previous
frame

Show playback time

 Play/pause: Play and pause the selected movie.
 Next frame: Move forward one frame. When movie playback is
paused, this allows you to advance the movie one frame at a
time.
 Previous frame: Move back one frame. When movie playback is
paused, this allows you to rewind the movie one frame at a time.
 Show playback time: Shows the playback time.
 Frame position slider: By dragging the slider left or right, you can
move the playback position while a movie is playing or paused.
 Frame no./Total frames: Shows the current frame number in the
movie being played back or shown and the total number of
frames.
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Mute/unmute
Volume slider
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Frame position slider
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 Movies shot with Canon Log (color space: BT.2020) are played
back in BT.709 color space.
 You cannot edit with the tool palettes (for RAW movies) in the
RAW movie tool while a RAW movie is playing back.
 You cannot use the [
] button for applying a Viewing LUT
while a RAW movie is playing back.
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Saving any Range of a RAW Movie as Still Photos
You can save any range of a RAW movie file as still photos.

a RAW movie file in the main window, etc., and
1 Select
start up the RAW movie tool.
 Start up the RAW Movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

2 Set the lead frame.
 Use the slider or [
] and [
] buttons to display the frame you
want to set as the lead frame in the frame display area, and then
click the [
] button.
 The in point marker ( ) moves, and the lead frame in the movie
is set.

3

Set the last frame.

4

Save the range.
 Specify the necessary settings in the window that appears by
clicking the [Save movie] button and save the range.
 The range is saved to the folder created in the destination folder
with the name of the movie file.
 Files are saved as a still photo (JPG/TIFF/DPX*) + an audio file
(WAV file) and numbered sequentially.
Note the following for [Save as type] that can be selected.
• When [HDR PQ] for the RAW movie is set to [On] : Only DPX*
is selectable.
• When Canon Log (color space: BT.2020)is set for the RAW
movie : Only DPX* is selectable.
• When Canon Log (color space: BT.709)is set for the RAW
movie : Only 16-bit TIFF format is selectable.
When selecting DPX, you cannot specify settings for [Image
quality], [Output resolution], [Embed ICC profile], or [Shooting
info setting].
For the files saved in DPX format cannot be viewed in DPP.
*DPX: Digital Picture Exchange
 If the movie was shot without audio on the camera, no audio file
(WAV file) is output.
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 Use the slider or [
] and [
] buttons to display the frame you
want to set as the last frame in the frame display area, and then
click the [
] button.
 The out point marker ( ) moves, and the last frame in the movie
is set.
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Grabbing and Saving any Range from a RAW Movie
You can grab and save any range from a RAW movie file.

any range of a movie file following steps 1 to 3 of
1 Set
“Saving any Range of a RAW Movie as Still Photos”
(p.161).

Click the [Grab and save] button.

2
3 Make required settings and click the [Save] button.
 The [Grab and save] dialog appears.

[Grab and save] dialog

Editing a RAW Movie
You can edit RAW movie files with the tool palettes (for RAW movies) in
the RAW movie tool.

1

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.
 Start up the RAW Movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

2 Edit.
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 The range is saved based on specified settings.
 Savable format is only CRM.
 Use the tool palettes (for RAW movies) to edit.
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Any image editing made to the original movie file is not carried over
to the new saved file.
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 The tool palettes (for RAW movies) other than the Settings tool
palette have the same basic functions as the original tool palettes
(p.46). See instructions for each original tool palette.
See the table below for differences in operation.
Icon

Tool palette name
Basic Adjustment tool
palette
(for RAW movies)

Tone Adjustment tool
palette
(for RAW movies)

Description
Differences from the Basic Adjustment
tool palette (p.48) are as follows:
• [Linear], [Clarity], [Adj face lighting] not
settable
• Automatic adjustment of gradation and
luminance not possible
• Only [Unsharp mask] settable for
[Sharpness]
Differences from the Tone Adjustment
tool palette (p.62) are as follows:
• If [HDR PQ] is set to [On], click white
balance is not available
Same editing possible as with the Color
Adjustment tool palette (p.67)

Color Adjustment tool
palette
(for RAW movies)
Detailed Adjustment tool Differences from the Detailed
palette
Adjustment tool palette (p.69) are as
(for RAW movies)
follows:
• [Reduce luminance noise] and
[Reduce chrominance noise] can be
adjusted using the slider only when
the [Noise reduction] checkbox is
checked (adjustment range: -10 to 10)
• [Reduce color moiré] not settable
• Only [Unsharp mask] settable for
[Sharpness]
Differences from the Lens Correction
Lens Correction tool
tool palette (p.74) are as follows:
palette
• [Chromatic aberration] and [Peripheral
(for RAW movies)
illumination] correction: click the
[
] button to apply shot
settings.
• [Distortion]: correction possible only
for images shot with an RF lens.
• [Digital Lens Optimizer] not settable
• [Diffraction correction] and [Color blur]
correction not possible

 The following tool palettes are unavailable for RAW movies:
Trimming/Angle Adjustment tool palette, Dust Delete/Copy
Stamp tool palette, Partial Adjustment tool palette, Settings tool
palette.
 Editing using the Settings tool palette

HDR PQ setting
Canon Log checkbox
Color matrix selection
Sharpness setting
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Work color space
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• You can set HDR PQ. When set to [On], the RAW movie file
selected with the RAW movie tool is displayed in HDR PQ. On
a system where display in HDR PQ is not possible, the movie
is converted and displayed in SDR based on the [HDR assist
display (movies)] setting in [Preferences] (p.179).
• Canon Log checkbox: If checked, you can perform color matrix
selection, sharpness setting, and color adjustment with this
tool palette. Only for movies shot on a supported camera
having RAW movie shooting and Canon Log set ON.
• Color matrix selection: Select from EOS Original and Neutral
color matrices.
• Sharpness setting: Set the sharpness.
• Color adjustment: Set the hue and saturation.
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• Work color space: When the Canon Log checkbox is
checkmarked, you can select either of BT.709 and BT.2020
work color spaces. Note that in DPP, movies cannot be
displayed in BT.2020 even if BT.2020 is set.
• Viewing LUT: Click the [
] button in the RAW movie tool to
apply a look-up table (LUT). This allows you to check the
movie with an image close to normal display.

3

Save the movie.
 Specify the necessary settings in the window that appears by
clicking the [Save movie] button and save the movie.
 Files are saved as a still photo (JPG/TIFF/DPX*) + an audio file
(WAV file) and numbered sequentially.
Note the following for [Save as type] that can be selected.
• When [HDR PQ] for the RAW movie is set to [On] : Only DPX*
is selectable.
• When Canon Log (color space: BT.2020) is set for the RAW
movie : Only DPX* is selectable.
• When Canon Log (color space: BT.709) is set for the RAW
movie : Only 16-bit TIFF format is selectable.
When selecting DPX, you cannot specify settings for [Image
quality], [Output resolution], [Embed ICC profile], or [Shooting
info setting].
For the files saved in DPX format cannot be viewed in DPP.
*DPX: Digital Picture Exchange
 If the movie was shot without audio on the camera, no audio file
(WAV file) is output.
 To exit, click the [Close] button.

 Editing performed with this function cannot be reverted to the
states in [Revert to shot settings] or [Revert to last saved settings]
in the [Adjustment] tab in the menu even if they are selected.
 If [HDR PQ] for a RAW movie is set to [On], and you try to display
the movie on a system where display in HDR PQ is not possible,
the movie is converted and displayed in SDR. A [
] is
displayed.
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HDR PQ Mode

System Requirements for HDR PQ Mode

HDR stands for High Dynamic Range and refers to technology that
enables expression of “a wider range of brightness” than with the
conventional range. The conventional range of brightness is referred to
as SDR (Standard Dynamic Range) = “standard brightness range” when
compared to HDR.
The “PQ” in this function’s name, HDR PQ, stands for Perceptual
Quantization and refers to the gamma curve of the input signal for
displaying HDR images. It is capable of brightness up to 10,000 cd/m2
and approximates human visual characteristics. HDR PQ mode displays
RAW images shot with a supported camera in HDR PQ (10-bit) on an
HDR display compliant with the HDR standard. (Actually displayed
images depend on monitor performance.)
You can also edit and save images.
In addition, DPP has the function “Creating HDR (High Dynamic Range)
Images” (p.110). However, this function assumes that display is in
conventional SDR, and combines exposure-bracketed images (HDR
compositing) to achieve image expression that uses a wide range of
gradation from shadows to highlights, and is thus different from HDR PQ
mode.

System Requirements
OS (operating
Windows 10 (Version 1607 or later), Windows 8.1
system)
CPU

Core i series 3.4 GHz or higher

RAM
(memory)

4.0 GB or more of RAM (8.0 GB or more
recommended)

RAW and DPRAW images shot, RAW movies shot
with the EOS R5
RAW images shot with the EOS R6
Supported
RAW images and RAW movies shot with the EOS-1D
images
X Mark III
RAW and DPRAW images shot with the EOS R,
EOS Ra or EOS 5D Mark IV
* Since HDR PQ cannot be displayed in Windows 8.1, images are
displayed in SDR according to the characteristics of the display so that
they approximate display in HDR PQ as much as possible.

Systems where images are displayed
accurately in HDR PQ
OS (operating Windows 10 Version 1803 or later
system)
GPU (video
card)

Video cards: NVIDIA GeForce GTX 10 series,
AMD Polaris architecture, etc.
(4 GB or more video memory recommended)

Display

Products that meet HDR10 standards*

Cable
HDMI 2.0a/b
* Images may not be displayed correctly depending on display and GPU
(video card) performance.
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Displaying Images in HDR PQ Mode
This section explains how to display images where system requirements
are as described in “Systems where images are displayed accurately in
HDR PQ” on the previous page. Additionally, in Windows, you must
specify the HDR option for display settings.
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Select an image in the main window, etc., and then
open the Settings tool palette and select [On] in
[HDR PQ].
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Check that checkbox in [Preferences]  [View
settings] tab sheet  [HDR display] is checked.
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 If not checked, checkmark the checkbox, click the [OK] button,
and then restart DPP.

 The image is displayed in HDR PQ mode.
 Images are displayed in HDR PQ only in the main window, the
edit image window, the preview window, second windows, and
the enlargement check screen. In other windows, images are
displayed in SDR according to the characteristics of the display
so that they approximate display in HDR PQ as much as
possible.
 The following icons are displayed in the preview window and
thumbnail frames for images displayed in HDR PQ mode.
• Thumbnail frame:
• Preview window (when connected to an HDR display):
• Preview window (when connected to an SDR display, when
the computer’s OS is Windows 8.1):

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies
HDR PQ
Mode

Specifying
Preferences

167

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images
Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

 HDR PQ mode display when an SDR display is connected
You can use images in HDR PQ mode also when connected to an
SDR display.
When an SDR display is connected, the image is displayed
according to the characteristics of the SDR display so that the
image approximates display in HDR PQ on an HDR display as
much as possible.
However, the large difference in regions that can be rendered
between HDR displays and SDR displays results in a different
impression of colors and gradations.
 HDR PQ mode display on a computer with a Windows 8.1
OS
If the computer’s OS is Windows 8.1, images are displayed in
SDR according to the characteristics of the display so that they
approximate display in HDR PQ on an HDR display as much as
possible. However, the large difference in regions that can be
rendered between HDR PQ and SDR results in a different
impression of colors and gradations.
 Recommended display environments for mixed HDR PQ
mode images and SDR images
It is recommended that you have a multiple-monitor environment
using two displays, an SDR display and an HDR display, when
using both HDR PQ and SDR display for images. On the SDR
display, you can display the DPP thumbnail display, tool palettes,
and SDR images, and you can use the HDR display to display the
HDR images.
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Cautions when Using HDR PQ Mode
Item
Quick check window (p.31)

Display function

Displaying AF points (p.22)
Displaying grid lines (p.22)

Restriction
Displayed in SDR according to the characteristics
of the display so that images approximate display
in HDR PQ as much as possible
Not displayable*

Highlight/shadow warning (p.23)

Not displayable

Displaying properties in preview image (p.24)

Not displayable*

Auto Lighting Optimizer (p.58)

Unavailable

Changing the Picture Style (p.49)

The following Picture Styles are available
- [Standard], [Portrait], [Landscape], [Fine Detail],
[Neutral], [Faithful], [Monochrome]

Basic Adjustment tool palette
Using Picture Style Files (p.51)
Linear (p.57)

Unavailable

Automatic adjustment of gradation and luminance (p.57)
Detailed Adjustment tool palette

Reducing color moiré in images (p.70)

Unavailable

Partial Adjustment tool palette

Reducing color moiré (p.84)

Unavailable

Setting the work color space (p.91)

Not selectable

Setting the size of RAW images when opening (p.93)

Unavailable

Settings tool palette

Tools

Compositing images (p.106)
Generating HDR (High Dynamic Range) images (p.110)

Unavailable

Using the soft-proof colors function (p.92)
Simulation function

Color matching settings (color setting of the monitor)
(p.178)
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* The function is available when using an SDR monitor.
 Since recipes that become attached to images when HDR PQ is set to On and when HDR PQ is set to Off are not compatible, neither can be applied
to the other.
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Switching between HDR and SDR modes clears the following recipes:
Basic Adjustment tool palette

Auto Lighting Optimizer / linear / Picture Style* / gamma adjustment

Tone Adjustment tool palette

Tone curve adjustment (RGB), brightness, contrast

Settings tool palette

Work color space, size when opening RAW images

Color Adjustment tool palette

Hue and saturation adjustments for the entire image, color adjustments for specific gamuts

Detailed Adjustment tool palette

Reducing color moiré

Partial Adjustment tool palette

Partial adjustments and reducing color moiré

Dust Delete / Copy Stamp tool
palette

Stamp
Dust delete data

* The recipe is cleared if the Picture Style was set to a style other than [Standard], [Portrait], [Landscape], [Fine Detail], [Neutral], [Faithful] or
[Monochrome].
Image quality enhancement in HDR PQ mode has been introduced as of Digital Photo Professional 4.10.40. To keep using previous adjustment
results, select the check box for [HDR PQ image quality settings*] in [Image Processing 2], in [Preferences].
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Saving Images Displayed in HDR PQ Mode in JPEG/TIFF Format
You can save the editing results of images displayed in HDR PQ mode
in the same way as SDR images.
 See “Saving Editing Results” (p.95) for information on how to save
images.
 When saving an image displayed in HDR PQ mode as a separate
image (JPEG or TIFF image), it is saved as an SDR image. The
image is processed so that it approximates display in HDR PQ on an
HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.
 For information on saving images in HEIF format, see “Saving Images
Displayed in HDR PQ Mode in HEIF Format” (p.172).
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When an image displayed in HDR PQ mode is saved as a separate
image (JPEG or TIFF image), the work color spaces of the saved
images are all fixed at sRGB.
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Working with Files Saved in HEVC Format
You must first install HEVC Codec (or enable it, depending on the
model) so you can display files saved in HEVC format* or save images
that are displayed in HDR PQ mode in HEIF format (extension: .hif).
HEIF stands for High Efficiency Image File format. Saving in HEIF
format allows you to save images while retaining the wide dynamic
range of HDR PQ.
*HEIF image files, HEVC compressed movie files

Preparation for Working with Files Saved in
HEVC Format (Display and Saving)
 To work with files saved in HEVC format, HEVC Codec must be
installed (or enabled, depending on the model).
 To work with files in HEIF format after shot on an EOS R/Ra, or EOS
5D Mark IV, download and install Canon HEVC Codec from the
Canon Web site. You should also start up DPP again after installing.
 To work with files in the above format shot on supported cameras, it is
necessary to enable HEVC Codec. Select the images in the main
window, and in the [Help] menu, select [Activate HEVC codec], and
follow the displayed instructions to enable it.
You should also start up DPP again after enabling.

Saving Images Displayed in HDR PQ Mode
in HEIF Format
 See “Saving Editing Results”  “Saving as a separate image” (p.95)
for information on saving images. When selecting the image type in
step 3, select [HEIF (*.HIF)] from [Save as type] and then save the
image.
 You cannot select the image quality or compression rate when saving
in HEIF format.
 You can [Save], [Save As], [Convert and save], or [Batch process]
HEIF images.
 You can save a HEIF image as a JPEG or TIFF image. (It is saved as
an SDR image.)
The image is processed so that it approximates display in HDR PQ on
an HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.
See “Saving Editing Results” (p.95) for information on how to save an
image as a JPEG or TIFF image.
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 When a HEIF image is saved as a JPEG or TIFF image, the work
color spaces of the saved images are all fixed at sRGB.
 HEIF files generated with software other than DPP are not
compatible with HEIF files saved in DPP. Only HEIF files saved in
DPP can be loaded into DPP.
 Images saved in HEIF format cannot be printed using Print Studio
Pro software for Canon inkjet printers.
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Specifying Preferences
You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.
Refer to the detailed explanations if available, as well as to each
window.
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General Settings
You can specify the folder that opens when DPP is started up, saving of
recipes, etc.
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Select the [Tools] menu  [Preferences].

1
a tab sheet, specify the settings, and then
2 Select
click the [OK] button.
 The [Preferences] window appears.

Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images
Remote
Shooting

 Movie file playback
Choose the application used for playing back movie files. Movies that
cannot be played back in DPP or EOS MOVIE Utility are played back
with the movie playback application specified with the computer’s OS
settings. For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.

 If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.
 If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies
HDR PQ
Mode

Specifying
Preferences

174

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images

 Default value of output resolution
When saving JPEG or TIFF images created by converting RAW images
(p.95, p.139), the resolution of the JPEG or TIFF images can be set.
 Temporarily saved files
You can delete temporarily saved files that were created and improve
operation speed, change file save destinations, or set a limit on disk
usage. Any changes you made will be applied when you start up DPP
again.
 [Delete] button:
Click the [Delete] button to delete
temporarily saved files.
 [Maximum available on disk]: Set with the slider (setting range: 0 to
32 GB).
Once usage reaches the limit, files
are erased starting with the oldest.
 [Destination]:
Click the [Browse] button to change
the save destination in the dialog that
appears.
 [Reset] button:
Click the [Reset] button to revert all
changes to the original settings.

Image processing
You can specify settings for processing images in DPP.

Image Processing 1
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 JPEG image quality
[Remove block noise and mosquito noise]
 You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.95, p.139) and for JPEG images that to
be saved with a different name. The higher the JPEG image’s
compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.
 Modified Picture Style settings
If you checkmark the checkbox, setting values for [Color tone], [Color
saturation], [Contrast], [Unsharp mask], [Sharpness], and other options
will be retained for each Picture Style.
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 Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
 When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
 When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

Image Processing 2
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For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.
For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.
 Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
 When [Apply camera settings] is selected, you can pre-set a
sharpness that suits the camera settings beforehand as the default.
 When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.
For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.
For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

Printing
Images

Processing
Large Numbers
of RAW Images

 Quick check window settings
You can specify image display settings for the quick check window. By
selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.
 Graphic processor settings
If you checkmark [Use graphics processor for image processing], the
graphics processor is used to allow a faster preview display. The CPU
handles convert and save tasks as well as print tasks as usual. Settings
will be applied the next time DPP is started up.
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 To use this function, a NVIDIA CUDA (Compute Capability 2.0 or
higher) GPU* with at least 1.0 GB of video memory is necessary.
Additionally, the latest NVIDIA GPU driver must be installed.
* GPU is an abbreviation of “Graphics Processing Unit”.
The [Use graphics processor for image processing] checkbox is
available only when a supporting GPU is installed.
 If the OS or other application software is using the GPU,
processing by the GPU may not be possible in some
circumstances. In such a case, the CPU handles processing as
usual.

Color Management
You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.
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 Default size when opening RAW images
This applies only to RAW images with the extension “.CR3” that were
shot with [
] selected on the camera.
This specifies the size defaults when RAW images are opened in DPP.
This default size is also set when RAW images are converted and saved
as JPEG or TIFF images.
The settings are applied the next time DPP is started up.
 HDR PQ image quality settings
Image quality enhancement in HDR PQ mode has been introduced as
of Digital Photo Professional 4.10.40. To keep using previous
adjustment results, select the check box for [HDR PQ image quality
settings*].
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 Default settings of Work color space
You can select the color space (p.186) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved (p.95,
p.139) or printed (p.132 to p.135).
 If you change the color space, and you restart DPP, the set color
space is applied as the default color space.
 You can check the color space that is set in an image in all windows
except the quick check window.
 If you checkmark [Use shooting color space as work color space],
the color space specified with the camera when the image was shot
will be set as work color space.
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Changes are not applied to the edited image
Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, cropped, dusterased) images. Change the settings individually.

View Settings
You can set layout for screen display.
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You can set a color space that is different from the default settings
for each image (p.91).
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 Color matching settings (color setting of the monitor)
Where a profile (p.185) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
 If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP. If you are using multiple monitors, the
profile set for each monitor is applied to DPP.
 Select the [Monitor profile], click the [Browse] button. You can
select a profile for your monitor in the dialog box that appears.
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Precise coloring with a third-party monitor color reader
If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.
 Printing profile (color setting of the printer)
Where a profile is not attached to the printer you are using to print
images, you can print an image, simulating the colors displayed on
screen by setting the profile in DPP.
When you set a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.
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 Thumbnail order
Specify the default order of images in the main window, and that the
order of rearranged images be maintained. If you checkmark the
checkbox, the order of rearranged images is maintained starting the
next time you select a folder (p.36).
 Reset user interface
You can reset user interface settings.
Choose from either of 2 reset states.
By checkmarking the [Restore defaults at startup] checkbox, settings
revert to their original settings for next time you start up DPP. The
checkmark is also removed from the checkbox for the next startup.
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 HDR assist display (movies)
This function provides an assisted display of CRM and MP4 files that
have [HDR PQ] set to [On] so that they are easier to view in an SDR
environment. The setting will be applied the next time DPP is started up.
However, this function is only effective in the RAW movie tool for CRM
files.
 Exposure prior. (mid-tones): maintains brightness where there are
medium tones in dark areas. Used for checking exposure.
 Tones prior. (highlights): maintains color reproduction and gradation
as much as is possible. Used for checking gradation in highlights.

Properties Display Settings
You can specify settings for shooting and recipe information that
appears with thumbnails and in the preview window.
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 View settings
You can specify information that appears on thumbnails or previews.
If the [Show Av/Tv/ISO on thumbnails] checkbox is checked, Av/Tv/ISO
information is displayed on thumbnails if thumbnails are set at Size 3 or
larger.
 Preview properties font
You can specify the font used for information displayed in the preview
window.
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 Properties to display
You can specify detailed settings for [Display settings for thumbnails
with info], [Display settings for thumbnail list], and [Display settings for
preview properties].
Items that can be selected appear in the list box at left, and actually
displayed items appear in the list box at right. Specify items with the
[Add >>] button and [<< Remove] button. You can also change the
display order with the [Move Up] button and [Move Down] button.
All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.

Survey
You can change survey send settings.
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 Click the [Change settings] button and change settings in the
dialog box that appears.
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Troubleshooting
If DPP is not operating correctly, refer to the subjects below.

Installation can not be completed correctly
 Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) when setting the user. You cannot install the
software if the user setting other than an administrator-level privilege
is selected. For detailed information on selecting an administratorlevel privilege, refer to your computer User’s Manual.

DPP does not work
 DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).
 Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card
 Depending on the card reader and computer OS used, SDXC cards
may not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility.

Images are not displayed properly
 Images that are not supported by DPP are not displayed. (Thumbnail
images are displayed as [?].) There are various types of JPEG and
TIFF images, so JPEG images other than Exif 2.2, 2.21 or 2.3
compatible images and TIFF images other than Exif compatible
images may not to be displayed properly (p.4).
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A recipe could not be pasted (applied) to another image
 Since recipes are not compatible between RAW images and JPEG or
TIFF images, neither can be applied to the other.

Colors are subdued in the image when viewed with
other software
 If a RAW image which has a color space other than sRGB is
converted and saved as a JPEG or TIFF image (p.91, p.177), the
colors will be subdued when viewed in software that is only
compatible with sRGB color space. In such a case, set the RAW
image’s color space to sRGB, convert and save again as a JPEG or
TIFF image, and then view the image.
 The Auto Lighting Optimizer (p.58) is a function compatible with
cameras equipped with the Auto Lighting Optimizer.
Adjustments made with the Auto Lighting Optimizer cannot be applied
to RAW images shot with the cameras not compatible with this
function.

The colors of the image displayed on screen and
the colors of the printed image do not match
 If the color of the monitor that displays an image is not adjusted
correctly, or if the profile for a printer that is to print image is not set
up, the color of the image displayed on screen and the color of the
printed photograph may differ greatly. If the color of the monitor that
displays images is corrected and the profile for a printer is set up
correctly (p.178), the color of a printed photograph and the color of an
image on screen can be more closely matched. Using a Canon printer
automatically sets up the profiles for the printer, so you only need to
set the color of the monitor to bring the colors closer to each other.

Printing a large number of images in batches
cannot be performed
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 If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.
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Deleting the Software (Uninstalling)
 Exit any applications before uninstalling the software.
 Log in under an administrator-level privilege when uninstalling the
software.
 Uninstall the software according to the OS software uninstalling
method.
 To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

1
2
3
4
5
6
7
8
9
10
11

Downloading
Images
Viewing
Images
Sorting
Images
Editing
Images

Printing
Images

Processing
Large Numbers
of RAW Images
Remote
Shooting

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies
HDR PQ
Mode

Specifying
Preferences

183

Image Frame Information in the Main Window and Edit Image Window (p.13, p.102)
Trimming (cropping) range*2 (p.71)
Check mark
(p.33, p.34)
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Pinned image setting mark (p.21)
Recipe mark

Multiple image display mark
(p.22)
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Image type*1
Rating mark (p.33, p.34)
Digital Lens Optimizer mark (p.79)

File name
GPS mark*3

Lens aberration
correction mark
(p.75)

Shooting
information

Split movie mark*4

Unsaved editing content mark

*1 Displayed on RAW+JPEG images displayed as a
single image (p.15).
[
] is displayed in RAW images.
[
] is displayed in Dual Pixel RAW images.
*2 When aspect ratio information is attached to an image
shot with any supported camera other than the EOS 5D
Mark II, the image is displayed as a cropped image.

*3 Displayed on images shot on a GPS functioncompatible Canon camera.
*4 Shows that the movie is split and includes movies
other than that shown in the thumbnail.
The following icons may be displayed:
: No final movie
: No initial or final movie
: No initial movie
: All split movies present

Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies

[
] is displayed in an image
frame when editing is not
possible.
Movies played back using
software other than DPP are
displayed with a [
] icon in the
thumbnail image.
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For information on icons displayed
in HDR PQ mode, see “Displaying
Images in HDR PQ Mode”
(p.167).
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Glossary
RAW image

bit number

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.
Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.
* “RAW” meaning “in a natural condition” or “not processed or refined”.

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.
The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

JPEG image
The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.
With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.
* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image
Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.
* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe
The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.
Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.
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Color Management System (Color Matching)
Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.
A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles
ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.
DPP has color management that uses these ICC profiles.

Tone Curve
A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Color space

CMYK simulation profiles

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.
sRGB :
Standard color space for Windows. Widely used for
the standard color space of monitors, digital
cameras, and scanners.
Adobe RGB :
A wider color space than sRGB. Mainly used for
printing for business purposes.
Apple RGB :
Standard color space for Macintosh. A slightly
wider color space than sRGB.
ColorMatch RGB : A slightly wider color space than sRGB. Mainly
used for printing for business purposes.
Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four
types of profile.
Euro Standard :
Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.
JMPA :
Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.
U.S.Web Coated :
Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.
JapanColor2001 type3 : Profile becoming a standard in the Japanese
printing industry, suitable for simulation of
JapanColor standard printing.

Color chart of color spaces compatible with DPP

Rendering intent
Color range that can be
seen by the human eye

sRGB
Adobe RGB
Apple RGB
ColorMatch RGB
Wide Gamut RGB

Gamma
value
2.2
2.2
1.8
1.8
2.2

White point
(color temp.)
6500K(D65)
6500K(D65)
6500K(D65)
5000K(D50)
5000K(D50)

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.
Perceptual :
Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.
Relative Colorimetric : There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index
A
Adjust Face Lighting ........................................................................... 59
Adjust JPEG Images........................................................................... 45
Adjust TIFF Images............................................................................. 45
Adjusting
Adjustment Contents (Recipe) ................................................... 100
Apply Adjustments........................................................................ 99
Automatic Adjustment (Gradation, Luminance)............................ 57
Brightness .............................................................................. 48, 62
Brightness of Highlights................................................................ 54
Brightness of Shadows................................................................. 54
Click White Balance ............................................................... 52, 63
Color Saturation ........................................................................... 55
Color Temperature ....................................................................... 53
Color Tone.................................................................................... 55
Contrast.................................................................................. 54, 62
Copy Adjustments ........................................................................ 99
Dynamic Range...................................................................... 56, 66
Filter Effect ................................................................................... 56
Hue......................................................................................... 67, 68
Monochrome .......................................................................... 55, 68
Personal White Balance ............................................................. 137
Picture Style File .......................................................................... 51
Saturation ............................................................................... 67, 68
Save Adjustments ........................................................................ 99
Sharpness .................................................................................... 59
Tone Curve Adjustment................................................................ 64
Toning Effect .......................................................................... 55, 56
White Balance .............................................................................. 51
Adjusting Brightness ........................................................................... 48
Adjusting Clarity .................................................................................. 61
Adjusting Tone Curve ......................................................................... 64
Adjustment Contents (Recipe) .................................................... 98, 185
Adobe RGB....................................................................................... 186
AF Points ............................................................................................ 22
Apple RGB ........................................................................................ 186
Arrange Images .................................................................................. 36
Auto Lighting Optimizer....................................................................... 58
Automatic Adjustment (Gradation, Luminance) .................................. 57
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Automatic Dust Erasure Processing.................................................... 87

B
Basic Adjustment Tool Palette............................................................. 48
Batch Apply White Balance to Images (Personal White Balance)..... 137
Batch Change the File Name of Images............................................ 142
Batch Convert/Save Images (Batch Process) ................................... 139
Batch Process (Batch Save JPEG and TIFF Images)....................... 139
Batch Process of Multiple Images
Change File Name ...................................................................... 142
Convert/Save (Batch Process).................................................... 139
Personal White Balance.............................................................. 137
Recipe Data .................................................................................. 98
Transfer....................................................................................... 141
Batch Settings Window.............................................................. 139, 141
Batch Transfer Images ...................................................................... 141
Batch Transfer Images to Image Editing Software ............................ 141
Before/After Comparison Display ........................................................ 24
bit Number ......................................................................................... 185
Bookmark ............................................................................................ 40
Brightness............................................................................................ 62

C
Change File Name............................................................................. 142
Change the Display ............................................................................. 14
Changing the File Name of Images in the Order in the Main
Window.............................................................................................. 142
Check Mark ........................................................................... 33, 34, 184
Chromatic Aberration Correction ......................................................... 75
Chrominance Noise Reduction............................................................ 69
Click White Balance............................................................... 52, 63, 147
CMYK Simulation .............................................................................. 186
Collection Window ............................................................................. 104
Color Blur Correction ........................................................................... 75
Color Chart ........................................................................................ 186
Color Management (Color Matching) ................................................ 185
Color Space ................................................................................ 186
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ICC Profiles ................................................................................ 185
Color Management (Preferences)..................................................... 177
Color saturation................................................................................... 55
Color Setting of the Monitor (Profiles)............................................... 177
Color Setting of the Printer (Profiles) ................................................ 178
Color Space ...................................................................................... 186
Adobe RGB ................................................................................ 186
Apple RGB ................................................................................. 186
Color Space Setting for Each Image ............................................ 91
ColorMatch RGB ........................................................................ 186
sRGB.......................................................................................... 186
Wide Gamut RGB....................................................................... 186
Color Space Setting for Each Image................................................... 91
Color Temperature.............................................................................. 53
Color Tone .......................................................................................... 55
ColorMatch RGB............................................................................... 186
Compositing Images ......................................................................... 106
Contrast ........................................................................................ 54, 62
Convert One Image............................................................................. 95
Convert to JPEG or TIFF Image and Save ................................. 95, 139
Copy Stamp (Image Correction) ......................................................... 90
Copying and Pasting (Applying) Recipes............................................ 99
Correct Images (Copy Stamp Function) ............................................. 90
Cropping ............................................................................................. 71
Customize toolbar ............................................................................. 127

D
Default Color Space Setting.............................................................. 177
Delete Images..................................................................................... 39
Deleting
Delete Images .............................................................................. 39
Delete the Software.................................................................... 183
Deleting DPP (Uninstalling) .............................................................. 183
Depth compositing ............................................................................ 117
Detailed Setting Printing (Printing with Shooting Information) .......... 133
Digital Lens Optimizer......................................................................... 78
Digital Lens Optimizer mark.............................................................. 184

Display
Before/After Comparison Display.................................................. 24
Enlarged Display (Preview Window) ............................................. 18
Enlarged Display (Quick Check Window) ..................................... 31
Multi-Function Preview.................................................................. 25
Single Image Display .................................................................... 37
Synchronize Preview Window..................................................... 101
Thumbnail Display (Main Window)................................................ 13
Thumbnail Display and Enlarged Display
(Edit Image Window)................................................................... 102
Displaying Image Properties................................................................ 24
Displaying Shooting Information.......................................................... 24
Distortion Correction............................................................................ 75
Downloading an Image to Your Computer .......................................... 11
Downloading Images from a Camera ........................................... 11
Downloading Images from a Card Reader.................................... 11
Downloading Images ........................................................................... 11
Downloading Images from a Camera .................................................. 11
Dual Pixel RAW Optimizer................................................................. 113
Dust Delete Data ........................................................................... 86, 87
Dust Delete/Copy Stamp Tool Palette................................................. 86
Dust Erasure Processing
Automatic Dust Erasure Processing ............................................. 86
Dust Delete/Copy Stamp Tool Palette .......................................... 86
Image Correction (Copy Stamp Function) .................................... 90
Manual Dust Erasure (Repair Function) ....................................... 88
Dynamic Range ............................................................................. 56, 66

E
Edit Image Window............................................................................ 102
Editing................................................................................................
187
Adjusting
Enlarged Display (Preview Window) ................................................... 18
EOS Utility ........................................................................................... 11
Exiting DPP ......................................................................................... 29
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Filter Effect .......................................................................................... 56
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G
General Settings (Preferences) ........................................................ 174
GPS mark ......................................................................................... 184
Grid Lines............................................................................................ 22

H
HDR (High Dynamic Range) Images ................................................ 110
HDR PQ Mode .................................................................................. 165
Highlight Area Warning Indicator ........................................................ 23
Histogram Palette ............................................................................... 17
Hue ......................................................................................... 46, 67, 68

I
ICC Profiles....................................................................................... 185
Image Information ............................................................................... 38
Image Marks (Image Frame Information) ......................................... 184
Image processing (Preferences)....................................................... 175
Image Quality
Noise Reduction ........................................................................... 69

J
JPEG Image................................................................................ 45, 185

L
Lens Aberration Correction ................................................................. 74
Lens aberration correction mark ....................................................... 184
Linear .................................................................................................. 57
Loading and Pasting (Applying) Recipes .......................................... 100
Luminance Noise Reduction ............................................................... 69

M
Main Window ......................................................................................
Main Window (Multi-layout).................................................................
Main Window (Thumbnail Layout) ......................................................
Manual Dust Erasure (Repair Function) .............................................
Monochrome .......................................................................................
Filter Effect ...................................................................................
Toning effect.................................................................................
Move or Copy Folders.........................................................................

13
20
13
88
55
56
56
40

Move or Copy Images ......................................................................... 39
Movies
Play Back .................................................................................... 150
Save Still Photos ......................................................................... 150
Split movie mark ......................................................................... 184
Multi-Function Preview ........................................................................ 25
Multi-layout .......................................................................................... 20
Multiple image display mark .............................................................. 184

N
Navigator Palette ................................................................................. 19
Noise Reduction .................................................................................. 69

O
Organize Images ................................................................................. 39
Organizing Images .............................................................................. 39
Delete Images ............................................................................... 39
Move or Copy Folders................................................................... 40
Move or Copy Images ................................................................... 39
Register Folders as Bookmarks .................................................... 40

P
Palettes
Display Method of Palettes ........................................................... 28
Rearranging Palettes .................................................................... 28
Perceptual ......................................................................................... 186
Peripheral Illumination Correction ....................................................... 75
Personal White Balance .................................................................... 137
Picture Style ........................................................................................ 49
Picture Style File.................................................................................. 51
Pin ....................................................................................................... 21
Pinned image setting mark ................................................................ 184
Preferences ....................................................................................... 174
Color Management ..................................................................... 177
General Settings ......................................................................... 174
Image processing........................................................................ 175
Properties Display Settings ......................................................... 179
Survey ......................................................................................... 180
View Settings .............................................................................. 178
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Preview Control Panel ........................................................................ 21
Preview Display Area.......................................................................... 20
Preview Window ................................................................................. 18
Printing
Printing a Thumbnail List (Contact Sheet Printing) .................... 134
Printing One Sheet of Paper ...................................................... 132
Printing with Shooting Information (Detailed Setting Printing).... 133
Printing One Sheet of Paper ............................................................. 132
Printing with Shooting Information (Detailed Setting Printing) .......... 133
Properties Display Settings (Preferences) ........................................ 179

Q
Quick Check Window.......................................................................... 31

R
Rating............................................................................................ 33, 34
Rating mark....................................................................................... 184
RAW Burst Image Tool ..................................................................... 122
RAW Image................................................................................. 44, 185
RAW Movies ..................................................................................... 153
Changing the Image Displayed for a RAW Movie ...................... 154
Editing a RAW Movie ................................................................. 162
Grabbing and Saving a Displayed RAW Movie Image............... 155
Grabbing and Saving any Range from a RAW Movie ................ 162
Playing Back RAW Movies......................................................... 160
Saving any Range of a RAW Movie as Still Photos ................... 161
Saving Several Still Photos from a RAW Movie ......................... 156
Starting Up the RAW Movie Tool ............................................... 157
Supported Cameras ................................................................... 154
Re-Adjusting an Image ....................................................................... 97
Recipe......................................................................................... 98, 185
Recipe File .......................................................................................... 98
Re-Editing an Image ........................................................................... 97
Registering Folders as Bookmarks ..................................................... 40
Remote Shooting .............................................................................. 144
Rename Window............................................................................... 142
Rendering Intent (Matching Method) ................................................ 186
Repair (Manual Dust Erasure) ............................................................ 88

Roll .................................................................................................... 122
Rotate Images ..................................................................................... 13

S
Saturation ................................................................................ 46, 67, 68
Save
Batch Convert/Save Images (Batch Process)............................. 139
Save .............................................................................................. 95
Save As......................................................................................... 95
Save As ............................................................................................... 95
Saving Recipes.................................................................................... 99
Second Windows................................................................................. 26
Select Images........................................................................ 13, 31, 102
Shadow Area Warning Indicator.......................................................... 23
Sharpness ..................................................................................... 59, 81
Shooting Information Display......................................................... 24, 38
Single Image Display........................................................................... 37
Single Image Display of RAW and JPEG Image ................................. 37
Soft-Proof Colors Function .................................................................. 92
Sorting Images
Check marks ........................................................................... 33, 34
Ratings .................................................................................... 33, 34
sRGB ................................................................................................. 186
Starting up DPP................................................................................... 10
Supported Images ................................................................................. 4
Survey (Preferences)......................................................................... 180
Synchronization (Preview Window) ................................................... 101
Synchronize Images .......................................................................... 101
Synchronize Preview Window ........................................................... 101
System Requirements ........................................................................... 3

T
Thumbnail Display (Filter/Sort Function) ............................................. 16
Thumbnail Display (Main Window) ...................................................... 13
Change the Display....................................................................... 14
Thumbnail Display (Multi-layout) ......................................................... 20
Thumbnail Display and Enlarged Display (Edit Image Window) ....... 102
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Thumbnail Display Area...................................................................... 20
Thumbnail Layout ............................................................................... 13
Thumbnails Control Panel................................................................... 15
TIFF Image ................................................................................. 45, 185
Tone Curve ....................................................................................... 185
Toning effect ....................................................................................... 56
Tool Palette......................................................................................... 46
Basic Adjustment Tool Palette ..................................................... 48
Color Adjustment Tool Palette...................................................... 67
Detailed Adjustment Tool Palette ................................................. 69
Dust Delete/Copy Stamp Tool Palette.......................................... 86
Lens Correction Tool Palette........................................................ 74
Partial Adjustment tool palette...................................................... 82
Settings Tool Palette .................................................................... 91
Tone Adjustment Tool Palette ...................................................... 62
Trimming/Angle Adjustment Tool Palette ..................................... 71
Toolbar................................................................................................ 13
Transfer
Batch Transfer Images to Image Editing Software..................... 141
Transfer an Image to Photoshop................................................ 126
Transfer an Image to Photoshop ...................................................... 126
Trimming (cropping) range................................................................ 184
Trimming/Angle Adjustment Tool Palette............................................ 71
Trimming/Angle Adjustment Window .................................................. 71

U
Unsaved editing content mark .......................................................... 184
Unsharp Mask..................................................................................... 60
Using Cloud Processing.................................................................... 128

Wide Gamut RGB.............................................................................. 186
Work Color Space ............................................................................... 91
Color Management ..................................................................... 177
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About This Instruction Manual
 It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.
 Canon may change without notice the software specifications and
contents of this Instruction Manual.
 The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.
 Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

V
View Settings (Preferences) ............................................................. 178
Viewing Images in the Main Window (Thumbnail Layout) .................. 13

W
White Balance..................................................................................... 51
Click White Balance ............................................................... 52, 63
Color Temperature ....................................................................... 53
Personal White Balance ............................................................. 137
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Trademarks
 Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
 Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
 All other trademarks are the property of their respective owners.
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